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Preface

Welcome to the Developing Extensions for Oracle JDeveloper.

Audience

This document is intended for developers that develop or use Oracle JDeveloper
extensions.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at ht t p: // www. or acl e. cont pl s/t opi ¢/ | ookup?
ctx=accé& d=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit htt p: / / www. or acl e. cont pl s/t opi ¢/

| ookup?ct x=acc&i d=i nfo or visit htt p: // ww. or acl e. com pl s/t opi ¢/ | ookup?ct x=acc& d=trs
if you are hearing impaired.

Related Documents

e Installing Oracle JDeveloper
«  Developing Applications with Oracle JDeveloper

e Developing Fusion Web Applications with Oracle Application Development
Framework

e Developing Web User Interfaces with Oracle ADF Faces
e Oracle JDeveloper 12¢ Online Help

e Oracle JDeveloper 12¢ Release Notes, link included with your Oracle JDeveloper
installation, and on Oracle Technology Network

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

ORACLE »
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Convention Meaning

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLSs, code
in examples, text that appears on the screen, or text that you enter.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle

Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/

lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.
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What's New Iin This Guide

The following topics introduce the new and changed features of Oracle JDeveloper
and other significant changes that are described in this guide, and provides pointers to
additional information. This document is the new edition of Developing Extensions for
Oracle JDeveloper.

New and Changed Features for 12¢ (12.2.1.3)

Oracle JDeveloper 12¢ (12.2.1.3) includes the following new and changed features for
this document:

*  No major feature changes in this release.

ORACLE .






Introduction to Developing Oracle
JDeveloper Extensions

Developing extensions to the JDeveloper integrated development environment (IDE)
lets you add additional features to JDeveloper.

The following sections provide an overview of using and developing JDeveloper
extensions:

e About Developing Oracle JDeveloper Extensions
» Developing Extensions with OSGi

e How JDeveloper Extensions Work

*  Migrating Extensions from Previous Releases

e Getting Started With Extension Development

*  Working with the Extension Manifest

e Working with the OSGi Manifest

1.1 About Developing Oracle JDeveloper Extensions

ORACLE

Oracle JDeveloper Extensions implement the most of the functionality in the
JDeveloper IDE. You can add existing extensions into JDeveloper, or you can build on
JDeveloper's native functionality by creating extensions to provide new features
tailored to your organization's development requirement.

A few of the functionalities include:

e To streamline your work flow.
* To use a third-party team development tool.
* To use software packages unique to your team.

* To help implement development standards and best practices with audit
extensions.

There are a wide variety of extensions readily available for you to download and use.
Some of these have been developed by Oracle, and some by third parties. These
provide new features to JDeveloper and integrate it with other applications that are
used by customers in their own development environments. For example, many of the
version control and team working systems available in JDeveloper are written and
distributed as extensions. The open architecture of JDeveloper means that you can
download and install them from Check for Updates on the JDeveloper Help menu.
Alternatively, you can install extensions:

*  From the Oracle JDeveloper Extensions page on the Oracle Technology Network
(OTN) at htt p: // www. or acl e. con t echnet wor k/ devel oper -t ool s/ j dev/
i ndex-099997. htn .

*  From a properly constructed ZIP file with a manifest that is in a location accessible
from your machine.
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# Note:

The recommended way of installing extensions to JDeveloper is to use Check
for Updates on the JDeveloper Help menu because only extension versions
that match the version of JDeveloper you are using will be available.

This same open architecture also makes it possible for you to write your own
extensions if you have specific needs or you would like to integrate JDeveloper with
some external process or tool that your development team uses. You can add menu
items, create context menus, integrate features into the JDeveloper toolbar, create
dockable windows that provide a view into your data objects, and more.

¢ Note:

The way that JDeveloper handles extensions changed in Oracle JDeveloper
11.1.2.nn. For information about extensions for earlier versions of JDeveloper,
see the online help in your version of JDeveloper.

Oracle extensions for earlier versions of JDeveloper, including the Extension
SDK, and third-party extensions for earlier versions of JDeveloper are
available from the Oracle JDeveloper Extensions page at http://

www. or acl e. com t echnet wor k/ devel oper -t ool s/ j dev/i ndex-099997. htmi .

Information about migrating extensions written for earlier versions of
JDeveloper is in Migrating Extensions from Previous Releases.

You can use JDeveloper's native features to develop your own extensions. See
Developing Extensions in JDeveloper .

For more advanced development, the JDeveloper Extension Software Development
Kit (Extension SDK) has been developed by the JDeveloper development team. It
includes a collection of projects containing sample code, and the javadoc-generated
documentation for the Extension SDK API which provides reference for classes and
other features used in extension development. It is available from Check for Updates
on the JDeveloper Help menu, and it contains much more complete documentation
and examples. If you are planning to do serious extension development, either to
provide wide support to an internal team or to develop an extension as part of a
product or third-party application to pass on to your own customers, it is highly
recommended that you download the Extension SDK. See Developing with the
Extension SDK .

You can use the Oracle JDeveloper page on the OTN forum to ask a question about
developing an extension, contribute to a discussion, or interact with other users. The
Oracle JDeveloper page on the OTN forum is located at htt ps: //foruns. or acl e. com
foruns/forum j spa?foruni D=83.

In contrast to the Extension SDK, JDeveloper also allows you to use external tools
without any coding:

* You can invoke command line interfaces

* You can pass parameters
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* You can add menus to JDeveloper

For information about developing extensions for JDeveloper, see "Working with
Extensions" in Developing Applications with Oracle JDeveloper.

For information about External Tools, see "Adding External Tools to JDeveloper" in
Developing Applications with Oracle JDeveloper.

1.2 Developing Extensions with OSGi

JDeveloper Extensions conform to the Open Services Gateway Initiative (OSGi).
The Open Services Gateway Initiative (OSGi) is a specification for building service
platforms running on top of a Java Runtime environment. JDeveloper is built as a set
of extensions which conform to OSGi, and any extensions that you write must also
conform to this standard.

For more information about OSGi, see the OSGi Service Platform Core Specification
Release 4, Version 4.2 which is available from htt p: / / www. 0sgi . or g.

The OSGi Framework can be divided into two main elements, both described below:

*  Service/Component Platform, that is the service providers, service requesters, and
service registry.

* Deployment Infrastructure, that is the service bundles which contain
implementation classes, resources, bundle metadata, and manifest file.

1.2.1 Service/Component Platform

The Service/Component Platform allows an OSGi implementation to activate, de-
activate, update and de-install existing services and to install new services
dynamically.

The Service/Component platform supports the interaction between 3 actors:

1. Service providers, which provide specific services and publish service
descriptions.

2. Service requesters, which discover services and bind to the service providers.

3. Service registry, which manages the publication and discovery of services based
on the registered service descriptions.

An OSGi service is a Java class or interface (service interface), along with a variable
number of attributes (service properties), which are name and value pairs. Service
properties allow differentiation between service providers which use the same service
interface.

The service registry allows services to be discovered by service requesters using
LDAP.

Service requesters can receive events signalling changes, for example, publication or
retrieval of a service in the service registry, using notification mechanisms.

1.2.2 Deployment Infrastructure

Services are packaged into service bundles which contain service implementation
classes and resources, along with the manifest file, mani f est . nf, which contains the

ORACLE 1-3
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bundle metadata. The manifest file contains information such as the service name,
version and dependencies.

Service providers and service requesters are part of a service bundle that is both a
logical and a physical entity. The bundle is responsible for run-time service
dependency management activities which include:

*  Publication
e Discovery
e Binding

e Adapting to changes resulting from the dynamic availability—the arrival or
departure—of services that are bound to the bundle.

When you create an extension in JDeveloper, it is composed into an OSGi service
bundle.

1.3 How JDeveloper Extensions Work

Discover about the concepts used in JDeveloper extension development.

Only those extensions load during the JDeveloper startup that are required for the user
to enhance the startup performance and overall memory usage. Some extensions
related terms and concepts are described below:

» JDeveloper users choose a role in which to work, and the role determines which
JDeveloper extensions are loaded because roles list the set of possible extensions
for that role. For example, the JDeveloper default role lists all extensions in the
Studio Edition.

* Initialization is an operation that involves calling the extension initialization code
Addin.initialize().Extension initialization gives the extension an opportunity to
initialize whatever it needs to function properly at the moment the end user is
about to exercise that extension's functionality.

The initialization list is a list of extensions previously initialized. These same
extensions are initialized when the user reopens a project recording this list.

e Trigger hooks are a set of declarative integration hooks that provide the
mechanism to trigger extension initialization. They are defined in the <tri gger -
hooks> section of the extension manifest ext ensi on. xni , and they are processed
when JDeveloper starts, even though your extension may not have been
initialized.

Any information the JDeveloper IDE needs about your extension at startup, such
as the gallery items it contributes, or the Java libraries it defines, or the node
recognizers it defines, must be provided in trigger hooks.

By contrast, the <hooks> section of the extension manifest is processed later when
your extension is initialized.

* Registration is an operation that involves reading and caching the trigger hooks
section of the extension manifest.

* Lazy initialization is the term for extensions not being initialized until their trigger
hook is activated.

*  Extension versioning is managed by OSGi. Two or more versions of the same
extension can be loaded at the same time, and if an extension is activated all

ORACLE 1-4
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dependent extensions are also loaded. OSGi handles the situation of an extension
depending on a certain version or range of versions.

* Extensions are class loaded in their own classloader. The extension lists the set of
packages that it exports to other extensions. The OSGi bundle manifest file
defines the Java packages that are made available to other bundles. Access to the
restricted classes is not possible, even using reflection, since OSGi protects them
by means of the extension's Java classloader.

* The OSGi service infrastructure dynamically manages service providers and
requesters.

» Extensions can have dependencies on other extensions. When an extension is
loaded, any other extension marked as a dependency in the OSGi bundle manifest
is also loaded. You may have already experienced this in JDeveloper, when you
have to click Load Feature, for example, in the Application Properties, Project
Properties, or Preferences dialog to start up a feature that you have not accessed
before, and have to wait while the relevant extensions load.

» JDeveloper extensions conform to the JSR 198 specification, which provides a
standard extension API for IDEs. Seehttp://jcp.org/en/jsr/detail ?i d=198.

1.3.1 How Extensions are Processed

There are two distinct phases to the way that JDeveloper processes extensions:

» Extension registration. This happens as JDeveloper starts up. It involves
registering all extensions available for the selected role. No extension code is
executed except for those extensions required to start JDeveloper.

» Extension initialization. This happens at any time the user accesses a functional
area registered by an extension during the extension registration phase. Therefore
you can see that an extension can be initialized at any time when JDeveloper is
being used.

1.3.2 Registering Extensions and Using Trigger Hooks

ORACLE

Extension registration is the JDeveloper IDE startup phase during which the extension
registry processes the <tri gger hooks> section of the extension manifest ext ensi on. xm
from all extensions available. During this processing no extension-specific code is

executed with the exception of translatable resources such as Java resource bundles.

Extensions can define extension specific trigger hooks using the <t ri gger - hook>
integration hook. If they do so, they must use the

oracl e. i de. ext ensi on. HashSt r uct ur eHook handler since the IDE will not execute
extension specific code unless that extension is initialized. The extension specific
trigger hook data will be available for retrieval in the Extension Registry. The extension
owning the trigger hook can retrieve that data once that extension is initialized. For
more information, see How to Register a <trigger-hook-handler>.

By contrast, other items that do not belong in the <tri gger hooks> section of the
extension manifest ext ensi on. xnl are initialized declaratively in the initialization phase
of the extension.

There are two types of trigger hooks, system and custom, and every extension is
initialized by:

* Being called from a system trigger hook

1-5
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Being called from a custom trigger hook

Being explicitly initialized by another, already initialized, extension

The types of trigger hook defined by the JDeveloper IDE are:

Menus: Only menus that qualify as an entry point to an extension should be menu
trigger hooks, and menus that are used to support an already initialized extension
should not be trigger hooks. For example, in the JDeveloper View menu, the
Breakpoints menu item is a trigger hook since a user will want to set breakpoints
before running the debugger, but the debugger subMenu in the View menu is not a
trigger hook since everything in it is only used once the extension is initialized.
From this you can see that menu items for uninitialized extensions are not visible
in JDeveloper.

Context Menus: Extensions can create custom trigger hooks that use context
menus as the trigger. There are no system-level context menu trigger hooks.

IDE Actions and Controllers: Only actions and controllers to support menu
trigger hooks should be registered. All other actions and controllers should
execute in the initialization phase. Any controller registered for a trigger hook
menu will not be able to run code to determine if their menu is disabled or not; it
must use declarative controller logic to specify when the menu is shown.

Gallery Items: Extensions can list items in the JDeveloper New Gallery using the
gallery item trigger hook. When the user opens a dialog or wizard from the New
Gallery it causes the extensions for that item to initialize, and any extension
marked as a dependency in the OSGi bundle manifest of this extension is also
loaded.

Technology Scopes: When a technology scope is added to a project, the
extension that registered that technology scope is initialized, along with any other
extension marked as a dependency in the OSGi bundle manifest.

NodeFactory Recognizers: This allows extensions to identify the nodes they
own. When a node becomes visible in the Applications window, if the extension for
that node is registered, it will be initialized. NodeFactory recognizers also handle
things like dragging a file from the desktop into JDeveloper.

IDE Preferences/Settings, Application Preferences/Settings, Project
Preferences/Settings: Uninitialized extensions will only show as a category listing
in the Preferences dialog (available from the Tools menu). It is not until a user
clicks on the category that they will be asked if they want to initialize the extension
at that point.

Singleton Registration: Singleton classes register as a trigger hook. When a
client requests a service from a singleton, the framework will check to see if that
singleton's extension has been initialized. If it has not, it will call for the extension
to be initialized. An example is the Log Manager.

Annotations: Extensions can register themselves as needing an annotation
trigger hook. They list out the annotation class names and when the user types
one of those annotations, we will initialize that extension at that time. The
annotation trigger hooks are used during Applications window node expansion to
determine icon overlays. When a parent node is expanded, the framework will look
for any annotations that are registered and if found, will supply the appropriate
icon for that node. The extension will not be initialized in the case where the node
icon overlay is applied.

Application and project migrators: These migrators must be defined
declaratively. Migrators specify the current versions supported. If the application or
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project file lists an older version of the migrator, or no version at all, JDeveloper
triggers the initialization of the extension in order to perform the migration of that
extension's data.

Library and Tag Library: When a library or tag library is added to a project, the
associated extension will trigger to initialize. In addition to this, when a project is
opened (not loaded), JDeveloper looks for libraries of that project and
automatically loads the extensions that are associated with that library or tag
library if they are not already loaded.

Custom Trigger Hooks: An extension can define its own trigger hook. This is
useful for the situation that an extension wants to allow clients to plug into it. An
extension defines its trigger hook in the same manner that it defines a regular
hook. Client extensions can then add a trigger hook registration (either system or
custom) into their extension manifest. When registering a trigger hook, the
extension specifies which extension(s) need to be loaded in order for the trigger to
take effect. These are called hook dependencies. JDeveloper ensures that this
hook is only processed when all the extensions listed as hook dependencies are
initialized.

1.3.3 How Lazy Initialization Works

To avoid initializing all extensions every time JDeveloper starts, lazy extension
initialization is used.

ORACLE

During JDeveloper startup, the IDE only executes Addin.initialize() code if the
extension that owns the Addin has been previously used by the end user in the
currently opened application or project. For more information, see Understanding
Node Recognizers.

Each extension identifies a type associated with their trigger hook so that this
hook:

— Can only be triggered when there is an application workspace open.
— Can only be triggered when there is a project open.

— Can be initialized at any time in the way that, for example, the HTTP Analyzer
can be.

As users work on an application in JDeveloper, the user's usage of extension
functionality is recorded in a project-specific extension initialization list. That way,
when the user stops working on a project by exiting JDeveloper and re-starting at
a later time, JDeveloper only initializes the extensions listed in the project's
initialization list.

For extensions that do not require a project, the information is stored in the IDE
preferences for the user.

When you are developing your extension you need to consider how the integration
points deal with lazy initialization. For example:

Extensions cannot assume that integration points are static; extensions must be
ready at any time during their life cycle to process and integrate new data
associated with their integration point.

For example, extension A has an API or a custom extension hook that allows other
extensions to register some listener class. Extension A cannot assume that all
such listeners are registered by the time extension A is initialized; other extensions
that depend on A can be lazy initialized later in the life cycle of ABC. Therefore,
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extension A must update its event firing code associated with these listeners to
deal with this effect of extension lazy loading. The way this is done is described in
the next point.

Extensions should use oracl e. i de. ext ensi on. HashSt r uct ur eHook to implement
custom integration hooks. This hook processing class has a property change
listener mechanism that lets clients know when new additional data is registered.
Your extension should listen for these property change events.

You should avoid having a deep dependency tree since this will cause the
initialization of all the extensions it depends on, which can diminish the
performance gains of lazy extension loading. If you find that your extension has a
deep dependency tree, you need to refactor the extensions to reduce the number
of extensions it depends on. For more information, see Understanding Large
Extensions.

1.4 Migrating Extensions from Previous Releases

Extensions developed for 11g and earlier versions of JDeveloper have to be updated
to run in in JDeveloper 12c.

If you have an extension that you developed for an earlier version of JDeveloper, you
will need to change it to run in the current release of JDeveloper. Section How
Extensions Work describes how extensions now work in JDeveloper, so you should
start by being familiar with the concepts described there.

ORACLE

The coding areas you need to consider are:

The Addi n.initialize method is no longer called at IDE startup. You must initialize
your extension using a trigger hook.Trigger hooks are defined in the extension
manifest extension.xml, and you can use one of the trigger hooks types defined by
the JDeveloper IDE, or create a custom trigger hook. For more information, see
Defining and Using Trigger Hooks.

Almost all <hooks> properties in the extension manifest ext ensi on. xm should now
be placed in <trigger hooks>.

In earlier versions of JDeveloper, role files were exclusionary, meaning that by
default all extensions were loaded and the role file told JDeveloper what not to
load. Now role files are inclusive; only extensions listed in a role are able to be
loaded when their trigger hook is activated.

All extensions have separate classloaders. As a result, code that calls package-
protected methods from classes in the same package but different extensions will
not work.

If your extension has custom integration points, these must be changed to handle
on-demand extension initialization. For more information, see How Lazy
Initialization Works.

Code that uses reflection to instantiate classes in an extension that it does not
have explicit dependencies on will not work.

There are a number of use cases in Use Cases for Developing Extensions that
describe situations you may encounter when you are converting your extensions to
use declarative trigger hooks support lazy initialization.
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1.5 Getting Started With Extension Development

Begin developing an extension by creating an application.

Whether you use the native features of JDeveloper to create an extension, described
in Developing Extensions in , or download the Extension SDK to develop an extension,
described in Developing with the Extension SDK , you start by creating an application
in JDeveloper along with one or more projects configured for extension development.

1.5.1 How to Create an Application and Project for Extension
Development

ORACLE

An application is the control structure for one or more projects. A project is a logical
container for a set of files that defines a program or part of a program. See "About
Working with Applications and Projects" in Developing Applications with Oracle
JDeveloper.

To create an application and project:

1. Open the New Gallery by choosing File > New.
2. In the New Gallery, in the Categories tree, under General select Applications.

3. In the Items list, double-click Extension Application. The Create Extension
Application wizard opens. For help with the wizard, press F1 or click Help.

4. Enter a name for the application and choose a location and an application package
prefix and click Next. The project, which is configured for extension development,
has a default name of Ext ensi on. If necessary, change the project name, then click
Next.

5. On the Configure Java Settings page you can set the default package, the Java
source path and the output directory. Make the changes you want, then click Next.

6. On the Configure Extension Settings page you can set options for the extension.

The extension project is created in the Applications window, and contains the
elements shown in Figure 1-1.

Figure 1-1 Extension Project in the Applications Window
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The extension project is created, along with a copy of the extension manifest
ext ensi on. xni and the OSGi manifest mani f est . nf . The extension manifest is opened in
the overview editor.

If for some reason you do not want to create an Extension application directly, you can
create a Custom application and select Extension Development as the project features
on the Project page of the wizard.

1.5.2 How to Develop for a Different JDeveloper Version

If you are developing an extension for a different version of JDeveloper, you choose
the platform when you create the Extension application.

# Note:

You can only develop an extension for more than one release of JDeveloper
when the versions are both minor releases of the same major release. For
example, JDeveloper version 11.1.2.nn can work with other 11.1.2.nn versions.
If you are using 12.1.2.nn then you can only develop extensions that will work
with other 12.1.2.nn releases.

The way that JDeveloper extensions are written changed in JDeveloper 11g
release 11.1.2.nn. To develop extensions for earlier versions of JDeveloper,
see the documentation in that version of JDeveloper.

To choose the JDeveloper version the extension is for:

1. Create an extension application.

2. On the Configure Extension Settings page, choose a different Target Platform. If
necessary, click the Manage Extension Platforms icon and choose the platform in
the Manage Extension Platforms dialog. For more help, press F1 or click Help in
the dialog.

1.5.3 Next Steps

Once you have created an application and project you can begin to develop the
extension:

* To continue by using the JDeveloper IDE to develop, for example, by creating an
extension Addi n, see Developing Extensions in .

e To use the samples in the Extension SDK to create your extension, or to use the
Extension SDK API, see Developing with the Extension SDK .

1.6 Working with the Extension Manifest

ORACLE

Learn about the extension manifest for JDeveloper extensions.

The extension manifest, ext ensi on. xni , controls many aspects of the extension. Before
you can deploy an extension, you must complete ext ensi on. xnl to, for example,
register trigger hooks. There can only be one ext ensi on. xni per project, and it must
always be in a directory called META- | NF.
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The extension manifest conforms to the JSR-198 specification, which is available at
http://jcp.org/ about Java/ communi typrocess/final /jsr198/index. htnl .

Hooks and trigger-hooks are set in the relevant sections of the extension manifest.
The <hooks> section of extension.xml is processed when the extension is initialized.
The <tri gger - hooks> section is processed when JDeveloper starts up.

JDeveloper has a dedicated overview editor for ext ensi on. xni , illustrated in Figure 1-2.

Figure 1-2 extension.xml in Overview Editor
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ORACLE

You edit ext ensi on. xn using the overview editor, where you enter information such as
details about dependencies into fields, and choose from lists of available objects, and
where you can use the Structure window and Property Inspector. To edit information in
ext ensi on. xni that is not available in the overview editor, you can either use the
Structure window or work in the ext ensi on. xni source, which you access by clicking
the Source tab.

For more information about dependencies, see Understanding Dependencies.

The template code for ext ensi on. xni created by creating an extension project contains
placeholders for the main elements, shown in the following example:

<extension id="extension" version="1.0.0" esdk-version="2.0" rshundl e-
cl ass="ext ensi on. Res"
xmns="http://jcp.org/jsr/ 198/ extensi on-manifest">
<name>${ EXTENS| ON_NAME} </ name>
<owner >${ EXTENS| ON_OANER} </ owner >
<trigger-hooks xm ns="http://xm ns.oracl e. coni i de/ ext ensi on" >
<l-- TODO Declare triggering functionality provided by extension: extension -->
<triggers/>
</trigger-hooks>
<hooks>
<l'-- TODO Declare functionality provided by extension: extension -->
</ hooks>
</ extensi on>
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1.6.1 Editing the Extension Manifest in the Overview Editor

The overview editor for ext ensi on. xm updates the extension manifest ext ensi on. xni
and the OSGI manifest mani fest. nf declaratively.

On the General tab of the overview editor for ext ensi on. xm you enter information
about the extension such as the extension name, the SDK version, and specify
features such as an icon and copyright information. This information populates the
f eat ur e- hook and pl at f orm i nf o elements.

The Runtime tab updates mani f est . nf and allows you to specify runtime values.

The Dependencies tab is where you can specify that this extension is part of another
extension, or alternatively specify that this extension is parent to another extension.
This populates the dependenci es element. The Hooks tab is where you details of
additional extensions to contribute functionality to your extension. For more
information, see Understanding Dependencies.

Use the Hooks tab to specify how the extension binds to the IDE.

The Hook Handlers tab allows you to define trigger hooks in your extension that can
be used as integration points by other extensions.

Detailed help, which describes the content of each field, is available by pressing F1
from any tab in the overview editor.

1.6.2 Editing the Extension Manifest in the Source Editor

You edit the extension manifest in the source editor using the XML editor, a
specialized schema-driven editor which includes a number of editing features including
Code Insight and XML validation. For more information, see "Using the XML Editors" in
Developing Applications with Oracle JDeveloper.

1.7 Working with the OSGI Manifest

ORACLE

Learn how to use the OSGi manifest when creating JDeveloper extensions.

The OSGi manifest, MANI FEST. M, lists the packages that the extension bundle exports.
There can only be one MANI FEST. MF per project, and it must always be in a directory
called META- | NF.

Although you can edit the OSGi manifest in the source editor, it is preferable to edit it
declaratively in the overview editor. For more information, see Editing the Extension
Manifest in the Overview Editor.

When a new extension project is created, a default MANI FEST. MF is created, and the
initial content is shown in the following example:

Bundl e- Mani f est Version: 2.0
Bundl e- Version: 1.0.0

Bund| e- Synbol i cNane: ext ensi on
Bundl e- O assPat h: .

Requi re-Bundl e: oracle.ide

For detailed information about the content of the OSGi manifest, see http://
WM. 0Sgi . or g.
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As part of the packaging process for an extension, JDeveloper updates mani f est . nf to
provide:

* Require-Bundle: Classes from another OSGi bundle that are required by your
extension are listed. Comes from the requi r e- bundl es elements in the extension
manifest.

* Export-Package: When you want to make Java packages in your extension
available to other extensions, these packages are listed.

» Bundle-ClassPath: If your extension needs to reference classes from a JAR
which is not an OSGi bundle it is listed. Comes from <dependenci es> elements in
the extension manifest.

These values are used in the OSGi Bundle Profile dialog. For more information, see
How to Create the Deployment Profile.

1.7.1 Understanding Dependencies

Extensions can depend on other extensions or JAR files. When you are developing
extensions for JDeveloper, you need to understand the dependencies upon the
extension, as well as the extension tree. You need to know the dependencies between
your extension and other extensions, that is whether:

* Your extension is part of another extension
*  One or more extensions are part of your extension

You also need to know the libraries and JAR files that need to be added. For example,
if you add a dependency on oracl e. j devel oper. maven. j ar, you must also add
dependency libraries for those JAR files delivered with the external Maven module.

Once you have worked this out, you set dependencies in the extension manifest, and
ensure that any libraries and additional JAR files are part of the extension bundle.

1.7.1.1 How to Set Dependencies in the Extension Manifest

ORACLE

When you create an extension project, the extension manifest is created and opened
in the overview editor. For more information, see Working with the Extension Manifest.

The order in which extensions are loaded depends on the entries in the extension
manifest.

To set dependencies in the Extension Manifest:

1. If necessary, open ext ensi on. xni in the overview editor by double-clicking on
extensi on. xm under META- | NF in the Applications window. Select the Dependencies
tab.

2. To specify that other extensions are dependent on this extension, use the Imported
Packages section.

For more help at any time, press F1 or click Help from the dialog.

The extensions you select as listed as <i mport > elements in the <dependenci es>
section of the extension manifest.

3. To specify extension requires classes from another OSGi bundle, use the Require
Bundles section to specify one or more bundles that depend on this extension.
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The extensions you select as listed as <bundl e> elements in the <requi r e- bundl es>
section of the extension manifest. When searching for a class, OSGi will search in
the order they are listed, so be sure to add the bundle to the proper location in the
list of bundles.

1.7.1.2 How to Set Dependencies in the OSGi Bundle Profile

As part of packaging up your extension, you create an OSGi bundle profile which is
used to determine the generated bundle manifest. For more information, see How to
Create the Deployment Profile.

ORACLE

The important entries to make on the OSGi Bundle Profile dialog are:

Package Exports: This is where you specify file groups that are contributors to
the Export-Package section of the generated bundle manifest. For example, if
there are Java packages in your extension which you want to make accessible to
other extensions, list the packages in this section.

Package Imports: This is where you specify file groups, library dependencies,
and profile dependencies that are contributors to the Import-Package section of
the generated bundle manifest.

Require Bundle: This is where you specify library dependencies and profile
dependencies that are contributors to the Require-Bundle section of the generated
bundle manifest.

The Library Dependencies page allows you to check the library dependencies for the
bundle, and the Profile Dependencies page allows you to examine and if necessary
change dependencies on other JAR deployment profiles in the application.
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Developing Extensions in Oracle
JDeveloper

This chapter provides an introduction to some of the features available to JDeveloper
extension writers, developers, and users, and offers examples of several of the
features that extension developers ask about most frequently. It describes the native
features of JDeveloper that you can begin using immediately to develop features for
an extension you plan to develop.

This chapter includes the following sections:

e About Developing Extensions in Oracle JDeveloper
» Use Cases for Developing Extensions

e Getting the JDeveloper Look and Feel

e Creating JDeveloper Elements

e Defining and Using Trigger Hooks

e Adding Online Help Support

e Adding Print Support

e Creating an Application or Project Template

2.1 About Developing Extensions in Oracle JDeveloper

Learn about the open archictured used by JDeveloper extensions.

JDeveloper uses an open architecture that makes it possible for you to write your own
extensions, if you have specific needs or you would like to integrate JDeveloper with
some external process or tool that your development team uses. You can add menu
items, create context menus, integrate features into the JDeveloper toolbar, create
dockable windows that provide a view into your data objects, and more.

2.2 Use Cases for Developing Extensions

Use these use cases to help you develop JDeveloper extensions.

This section outlines a series of use cases that you may encounter when planning
your extension or if you are converting an existing extension written for an earlier
version of JDeveloper to use declarative trigger hooks and support lazy initializations.
Follow the recommendations here to create extensions that load and execute quickly.

2.2.1 Understanding Rules Based Menu Sensitivity

ORACLE

Extensions control menu sensitivity by setting the enabled state of the action
associated with a menu item, which is determined by one of the
oracle.ide.controller.Control | ers associated with that action. Since actions are
trigger hooks, oracl e. i de. control | er. Control | er implementations associated with the
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action are not called unless the extension that owns the controller has been initialized.
For an example of setting simple rules, see How to Define Simple Rules.

Consider the following general situation: Menu item M1 is associated with action Al,
which in turn is associated with several controllers. These controllers, in turn, are
allowed to indicate whether they handle action Al for the given context. The first
controller that handles the selected action sets the action's enabled state.

As a specific example, EditCopy is associated with acti on | deConstants. COPY_CVD I D,
which in turn is associated with a controller that knows how to copy text, and another
controller that knows how to copy visual objects, such as Ul components.

In the past, use cases following this pattern have led to performance problems, when
menus are shown or when toolbar buttons change their enabled state as JDeveloper
changes context—for example, when the user changes the current selection, changes
the current view, or changes the current active project.

To prevent time-consuming operations in these situations, develop your extensions'
menus using rule-based action sensitivity control. Controllers are defined declaratively
in the extension manifest file. For more information, see Working with the Extension
Manifest.

Part of the controller definition specifies action update rules, which control the action-
enabled state:

* Enable "Always"

» Enable when "Active application present”

- Enable when "Active project present"

» Enable when "Context has a node"

» Enable when "Context has a node of type X"
« Enable when "Context has selection"

- Enable when "Context has single selection"

» Enable when "Context has multiple selection"

Controller can define multiple rules, and the most specific rules must appear first in the
rule definition list.

JDeveloper analyses the controller rule-based sensitivity before the extension that
owns the controller is initialized. Once the extension is initialized, the extension's
Control | er. updat e() method handles the action-enabled state. If no controller does so,
extension operation follows the rules as defined. The recommended way is to have all
Control |l er. update() methods return fal se so as not to interfere with GUI
responsiveness.

2.2.1.1 How to Avoid Complex Controller.update() Implementations

ORACLE

Controllers specify the rules that determine the enabled state of an action
declaratively, using the action-enabling rules described in Understanding Rules Based
Menu Sensitivity. If your menu is enabled and the user executes it, the extension can
then perform the operations needed to ensure that menu execution works properly.

Earlier implementations of Control | er. updat e() used to execute complex and time-
consuming code in order to determine the action enabled state. The current menu
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sensitivity model allows the enabled state of an action to be determined declaratively,
and reduces the time involved in choosing the appropriate action to perform.

The rules that control controller behavior are as follows.
When the extension is initialized:

e A menuis about to be shown:

— Ifitis a rules base controller, the rule will be evaluated. If f al se, the menu is
grayed out by the framework. If t rue or not a rules-based controller, see the
next bullet point.

— Controller.update() is called. If it returns true, no other controllers are
processed. The controller must set the enabled/disabled state of the action
inside the updat e() method.

* The user selects an active action. Control | er. update() is called. If it returns t r ue,
no other controllers are processed. The controller must set the enabled/disabled
state of the action inside the updat e() method.

When the extension is not initialized:

A menu is about to be shown. The rule for the controller is evaluated. If f al se, the
menu is grayed out by the framework. If t rue it is activated by the framework.

*  The user selects an active menu on an extension that has not been initialized:

— Controller.update() is called. If update() returns fal se an exception will be
thrown to say that when the controller's rule is evaluated to tr ue, the
controller's updat e() method must also return true, and a log message is
displayed to remind you. If updat e() returns true, go to the next bullet point.

— The action will be checked to see if it is enabled/disabled. If the action is
enabled, Control | er. handl eEvent () will be called. If the action is disabled, go to
the next bullet point.

— If the controller is a Tri gger Control | er, the framework will display a message
to the user telling them why the action cannot be performed. If it is not a
Trigger Control | er, an exception will be thrown telling the you that this
controller needs to be a Tri gger Control | er.

Therefore if the conditions in the first or third bullet points occur, you need to
address them declaratively.
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Figure 2-1 Flow Diagram for Unitialized Extension
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2.2.2 How to Use Dynamic Menu Labels and Icons

Dynamic menu labels and icons are menu items that vary depending on which
application, project or node the user selects. From within your extension, dynamic
menu labels execute code when selected in order to modify the menu label string
and/or icon that is displayed when the user selects the menu.

2.2.2.1 How to Append the Short Name to the Menu Label

When the user selects a dynamic menu, JDeveloper appends the selected element
short label to the menu item label. You can see this in:

Run > Run myproject.jpr

In general, these menus depend on the selected application, project, node, or element.
Using the controller hook, extensions can request that JDeveloper update the label
based on the action update rules. For more information, see Understanding Rules
Based Menu Sensitivity.

This updates the menu label, adding the short name associated with the element
specified by the rule. This element can be an application, project, or node.

2.2.3 How to Construct Dynamic Top Menus

ORACLE

When constructing dynamic top level menus, such as the Source top level menu,
define them declaratively using the same trigger hooks as top level menus. For more
information, see How to Create and Modify Menus.

What determines whether a menu item is included in the dynamic top level menu are
both:
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» Editor type
*  Menu type

When these two conditions are met, the dynamic menu declaratively defined for the
active editor and node opened is displayed as a top level menu. When the extension
user selects this menu, menu item sensitivity is handled by setting the enabled state of
the action associated with a menu item. For more information, see Understanding
Rules Based Menu Sensitivity.

2.2.4 Understanding Node Recognizers

Node recognizers are responsible for recognizing the or acl e. i de. nodel . Node subclass
associated with a resource pointed to by a specific URL.

JDeveloper provides two standard recognizers:

* One that can recognize node types such as file extensions, based on information
provided by the URL itself.

* One that can recognize XML node types, based on the content of an XML file.

In previous versions, JDeveloper also allowed custom recognizer implementations to
be registered. This is now deprecated.

The Addin.initialize() method registers a custom implementation of the
oracle.ide.mode.Recognizer class using one of these methods:

* Recogni zer.regi sterRecogni zer (String, Recognizer)
* Recognizer.registerRecogni zer(String[], Recognizer)
* Recogni zer.regi sterLowPriorityRecogni zer (Recogni zer)

Extensions that provide custom recognizers must adjust their node recognition in such
a way that it can be handled by the recognizers in JDeveloper.

If you are rewriting an extension developed for an earlier version of JDeveloper that
used the IDE standard recognizers, you need to remove the recognizer registration
code from the Addin.initialize() method and use the recognizer trigger hook to
register recognition rules in the extension manifest file, ext ensi on. xnl . For more
information, see Recogni zer in the Java API Reference for Oracle Extension SDK and
Working with the Extension Manifest.

2.2.5 Understanding Content Sets

ORACLE

JDeveloper uses content sets to define the categories that are displayed as nodes in
the Applications window. The categories in installed JDeveloper include:

*  Application Sources
*  Web Sources
e Resources

Content sets are registered declaratively, but do not trigger initialization of the
extension that introduced the content set, because content sets require no custom
behavior. You must provide the content set ID, label, and default URLs that indicate
where to look for content in your extension.
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Instances of Cont ent Level Fi | ter provide client behavior that control what is shown
under a content set.

A Content Level Fil ter is responsible for filtering the breadth-first traversal implemented
by the Cont ent Level class to provide a virtual representation of each level that differs
from its physical representation. A Cont ent Level Fi | ter may:

* Add new elements to be displayed.

* Remove elements from the display.

*  Remove subdirectories from the display.

* Cause a subdirectory to be displayed even if it is empty.

Instances of Cont ent Level Fi | ter are registered statically via the static method
addCont ent Level Fi | ter (Cont ent Level Fi I ter) in the class Cont ent Level .

After a new application is created or opened in the Applications window, if the
extension user expands the top-level folder of a project, before adding all the folders
and files in such project (which uses method open in BaseTr eeExpl or er ) the method
appl yCont ent Level Fi I ters(Context, List, List) inclass ContentLevel is called. This
method:

1. Gets all the source root directories.

2. Checks that, for each of the instances of Content Level Fi | ter registered, whether a
filter can be applied to the given Cont ext . If it can, it calls the method
updateDi r (URLPath, String, List, List, Context context) which can modify the
lists of elements and subdirectories for each level before they are displayed.
Whenever there are multiple instances of Cont ent Level Fi | ter applying changes to
the same level, later filters will see the effect of earlier filters and, if appropriate,
perform further filtering on them.

3. Does the same as in the previous step for instances of
AsynchronousCont ent Level Fi | ter, Cont ent Level . It also obtains a Cal | abl e from such
a filter, which performs an asynchronous request to get additional elements.

# Note:

To find out whether a Content Level Fi | ter can be applied to a Cont ext,
Content Level retrieves all the content set keys from that filter and checks to
see whether the context has at least one of the keys as property.

Content Level Fi | ter does not need declarative registration. Before filtering takes place,
nodes are created using NodeFact ory, which uses recognizers to create nodes from
URLSs. Since recognizers are trigger hooks, by the time filtering takes place, related
extensions are already initialized.

In general, extensions that register content level filters also register recognizer rules;
therefore, they are always initialized if a node type is recognized by the recognizer
rules they registered. For example, the Applications window ensures that as the user
expands folders in the Applications window, it creates instances of nodes for all files
found under that folder, which triggers extension initialization. At that point, JDeveloper
invokes the content level filters giving these a chance to filter out nodes or add other
nodes to display under the folder being expanded.
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2.2.6 Understanding Large Extensions

Extensions that provide a wide set of functionality and have a deep dependency tree
are considered large extensions. In general, initializing large extensions causes the
pre-initialization of a number of other extensions due to their deep dependency tree. In
many cases extension users may only be accessing a subset of the wide functionality
provided by a large extension but, inadvertently, they get more than they require due
to the monolithic structure of this type of extension.

To improve the performance of a large extension, it is recommended that you refactor
large extensions following one of these models:

» ldentify the extension's main functional areas and refactor prominent areas into
separate extensions; or

» Keep abstract functional areas in a single extension with a shallow dependency
tree, while moving functional implementation details to separate extensions.

The first model works best when functional areas have simple dependencies between
them. For example, consider an extension, E1, which has two functional areas: X and
Y. A simple dependency means that refactoring extension E1 into extensions E2 and
E3 introduces no bi-directional dependencies between E2 and E3, or if it does, these
can be resolved by introducing a support module, (for example, module M1), which
provides the functionality both E2 and E3 need. It is important that M1 not have the
same dependency tree as E1; this defeats the purpose of the refactoring exercise,
which was to reduce the number of extensions that need to be pre-initialized before
the functionality provided by E1 can be exercised. Ideally, extensions E2 and E3 do
not depend on each other and the original dependency tree from extension E1 is now
evenly distributed between extensions E2 and E3.

The second model leaves a version of extension E1 that has a very shallow
dependency tree. In order to reduce the dependency tree, the refactoring operation
must move the implementation of functional areas E2 and E3 to extensions E2impl
and E3impl. For this pattern to work, it is very important that E1 does not depend on
extensions E2impl and/or E3impl. To support this pattern, use the si ngl et on- servi ce-
hook which makes sure that the right implementation, say the E2impl extension, is
initialized when functionality E2 is accessed through extension E1. By using the

si ngl et on- servi ce- hook, E2impl is initialized even though E1 does not depend on that
extension. For more information, see the section in Singleton registration in Defining
and Using Trigger Hooks.

2.2.7 Understanding Technology Scopes

ORACLE

When the user selects a technology scope, the extension that introduced that
technology scope along with all the other extensions it depends on is initialized. The
deployment dependencies are stated in their projects' deployment profiles. For more
information, see "Deployment Profiles" in Developing Applications with Oracle
JDeveloper.

If the user's selection makes it necessary to initialize extensions outside the
dependency tree of the extension introducing the technology scope, the recommended
method of handling this is to wait for the user to use some functional aspect of your
extension that triggers extension initialization. This avoids the concept of the feature
set, which would require initializing all members of the feature set and defeat the
purpose of lazy initialization.
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2.3 Getting the JDeveloper Look and Feel

Create a JDeveloper extensions that matches the look and feel of JDeveloper.

ORACLE

You can develop extensions that blend seamlessly wit
guidelines in this section. For example, you can use st
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h JDeveloper by following the
andard spacing and alignment

for common components by using the Ul constants published in the
oracl e.javat ool s. ui . Layout Const ant s to achieve the recommended spacing. The

spacing can be used for all components, whether they
modeless overview editors.

are in dialogs, wizards or

Figure 2-2 shows the standard spacing used for elements in a JDeveloper dialog.

Figure 2-2 JDeveloper Dialog Showing Spacing
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Figure 2-3 shows the spacing used for an overview edi

tor in JDeveloper.
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Figure 2-3 Overview Editor Showing Spacing
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2.4 Creating JDeveloper Elements

Use elements such as menus, windows, wizards, editors, explorers for your

JDeveloper extension.

This section describes how to work with and develop various JDeveloper elements:

e Menus

e Windows and views

e Wizards that can be invoked from the New Gallery or from the Tools menu

e JDeveloper commands
e Source editors

e Explorers

e File types

e Components window

» JDeveloper preferences

e Making changes undoable

The Extension SDK provides examples of these and other elements. See Developing

with the Extension SDK .

2.4.1 How to Quickly Create JDeveloper Elements

There are some JDeveloper elements that you can create quickly from the New

ORACLE

Gallery:

* Actions, that is operations that the extension user may invoke in the IDE. For
information about Actions, see How to Define an Action.
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* Addins, which can perform programmatic initialization and registration for an
extension while JDeveloper is starting up. For information about Addins, see How
to Implement the Addin Interface.

» Data models, which subclass HashSt r uct ur eAdapt er to store the persistent data
model for preferences or project properties. For information about data models,
see How to Implement the Data Model.

e Wizards that can be invoked from the New Gallery or Tools menu. For information
about wizards, see How to Develop Wizards .

* New panels in the Preferences dialog. For information about working with the
Preferences dialog, see Understanding Preferences.

* New panels in the Project Properties dialog. For information about project
properties, see Understanding Project Properties.

» Freemarker file templates that you can use in an extension hook defined file
template.

To quickly create a JDeveloper element for the New Gallery:

1. Open the New Gallery by choosing File > New.
2. In the New Gallery, in the Categories tree, under General select Applications.

3. Inthe Items list, double-click Extension Application. The Create Extension
Application wizard opens. For help with the wizard, press F1 or click Help.

4. Enter a name for the application and choose a location and an application package
prefix and click Next. The project, which is configured for extension development,
has a default name of Ext ensi on. If necessary, change the project name, then click
Next.

5. Open the New Gallery by choosing File > New.

6. Inthe New Gallery, in the Categories tree, under Client Tier select Extension
Development.

7. In the Items list, double-click the JDeveloper element you want to create. The
appropriate dialog opens. For more help, press F1 or click Help from the dialog.

2.4.2 How to Create and Modify Menus

Because so much of a user's interaction with JDeveloper is through the menus,
JDeveloper lets you modify existing menus and create new ones. In addition to adding
selections to the items in JDeveloper's menu bar, you can also add context menus that
give you finer control over user interactions with the functions provided by your
extension.

Menus interact with the command extension, which in turn relies on the Addi n interface.
For more information, see How to Develop Commands .

2.4.2.1 Understanding Menus

ORACLE

Menus are an important way to integrate your extension's functionality into
JDeveloper. You may wish to add a major feature—selecting a versioning system, for
example, or accessing an internal code-snippet database—to JDeveloper's menu
system, so that your extension can be accessed or controlled through a selection from
the menu or tool bar. On the other hand, some features of your extension—checking
out a file from your organization's versioning software or verifying code with your
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organization's preferred tool—might best be handled through a context menu that pops
up when the user clicks the right mouse button in the appropriate place. JDeveloper's
extension system lets you do both. For more information, see How to Create a Context
Menu.

JDeveloper includes a class to support the declarative creation of context menus,
which can then be hooked to the main JDeveloper functionality by a series of listeners
and controllers. This lets you create menu-based extensions that fit within the structure
and user interface of JDeveloper, while adding features and capabilities beyond the
basic IDE. For more information, see How to Invoke an Addin From a Context Menu.

Alternatively, your extension might have features that already fit within the existing
menu structure of JDeveloper, but add unique functions to each of the current menus.
In this case, your extension needs to add specific new options to existing menus. For
more information, see How to Add Menu Items to an Existing Menu.

You can also use a similar technique to add new selections to a toolbar. For more
information, see How to Add a Drop-down Button to a Toolbar.

2.4.2.2 How to Create a Context Menu

Creating a menu declaratively using the context menu listener classes lets you use
standard classes. This helps make your extension easy to update, adds consistency
across all menus, helps your extension load quickly, and can require no custom code
to develop. You can use the existing context menu listener classes, by registering
them, using the callback interface that lets you add menus to your extension, and
finally by using the controller associated with the specific view for which the menu is
created. For more information, see How to Invoke an Addin From a Context Menu.

To create a menu with several selections:

» Register the context menu listener classes in your extension manifest using the
sample code in the following example:

<extension xm ns="http://jcp.org/jsr/ 198/ ext ensi on- mani f est"

<l--
Define an action that will be used in various nmenus and tool bars
You can set any Swing action property on the action. The controller
class inplenments oracle.ide.controller.Controller and determi nes
when the action is enabled and what it does

You can use an anpersand (escaped as &anp;) in the Name property
to specify the menonic for any menu items containing the action
>
<actions xmns="http://xm ns.oracl e. conljdevel oper/ 1013/ ext ensi on">
<action id="oracle.ide.extsanples.first.invokeAction">
<properties>
<property name="Nane">&anp; Ext ensi on SDK First Sanpl e</property>
<l-- use an icon, stealing this one from predefined icons
meke sure you have oracle.icon as a required bundle to
pick up this icon at run time fromthe icons nodule -->
<property nanme="Smal | | con">${ Or acl el cons. LABEL} </ pr operty>
</ properties>
</ action>
</ actions>

<controllers xm ns="http://xm ns. oracl e. conii de/ ext ensi on">
<control | er class="oracle.ide.extsanples.firstsanple.SinpleController">
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<updat e-rul es>
<updat e-rul e rul e="al ways-enabl ed" >
<action id="oracle.ide.extsanples.first.invokeAction">
<l abel >ESDK Sanpl e Action</| abel >
</ action>
</ updat e-rul e>
</ updat e-rul es>
</controller>
</controllers>

<l--
Install context nenus in the navigator, editor, and structure pane
(explorer)
whi ch use the sane action defined above
-->

<cont ext - menu- hook rul e="al ways- enabl ed" >
<site idref="navigator, editor, explorer"/>
<menu>
<I-- '"weight' is used to control where the section appears in
the nenu. Weights are sorted in ascending order, each unique
value is its own section. -->
<I-- section el ement must be in namespace
http://jcp.org/jsr/ 198/ extension-manifest. -->
<section xmns="http://jcp.org/jsr/ 198/ extension-manifest"
i d="MY_CUSTOM MENU_SECTI ON_ONE" wei ght="1.0">
<I-- For nenu items and subnenus, weight determnes the
order within a nenu section. Itens are sorted in ascending
order or in the order they are added if the weight is not
uni que. -->
<itemaction-ref="oracle.ide.extsanples.first.invokeAction"></iten»
</ section>
</ menu>
</ cont ext - menu- hook>

<nenu- hook xm ns="http://jcp.org/jsr/ 198/ extensi on-manifest">
<l--
Add the action in its own separator group at the top of the File
nenu
-->
<menus>
<menubar id="javax.ide.view. MAI N_W NDOW MENUBAR_| D" >
<menu id="javax.ide.FILE_MENU | D'>
<section id="esdksanpl e. cust onsection"
bef ore="j avax. i de. NEW SECTI ON_| D" >
<itemaction-ref="oracle.ide.extsanples.first.invokeAction"></
iten
</ section>
</ menu>
</ menubar >
</ menus>

<l--
Add the action as tool bar button in its own separator group
imedi ately after the
existing "save" tool bar buttons
-->
<t ool bar s>
<tool bar id="javax.ide.view MAI N_W NDOW TOOLBAR_| D" >
<I-- Add a new section after the first section in the toolbar. -->
<section id="javax.ide.tck.tool bar.testsection"
after="javax.ide. NEW SECTION_| D'>
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<itemaction-ref="oracle.ide.extsanples.first.invokeAction"></iten»
</ section>
</t ool bar >
</t ool bar s>
</ menu- hook>

</triggers>
</trigger-hooks>

<hooks>
<l--
The feature hook controls the display of the extension on the
Ext ensi ons page of preferences
-->
<f eat ur e- hook>
<description>Denonstrates installing nenu, toolbar and gallery itens.</
description>
<optional >true</optional >
<part-of >oracl e.ide. extsanpl es. al | sanpl es</ part - of >
</ feat ure-hook>
</ hooks>
</ extensi on>

2.4.2.3 How to Improve Performance by Registering a Context Menu Listener

Registering a context menu listener makes sure your context menus pop up quickly.

Context menu listeners should do the minimum amount of work so that they do not
delay the popping-up of context menus. Currently, there are close to 250 menu
listeners for the Applications window context menu, therefore, on average listeners
have to take less than 4 milliseconds for the context menu to pop up in less than a
second.

Here are some tips for improving performance:

» If your extension is interested in certain nodes only, your context menu listeners
should be registered for that specific node type. This guarantees that your listener
is only called when the user of your extension clicks on a node of that type.

*  When your listener's menuW | | Show method is called, your only action should be to
add your menu item. Protect against non-applicable contexts when your menu
item action is executed.

e Your listener's menuW | | H de method should do nothing.

The following things have a negative impact on context-menu performance:
»  File I/O operations.

» Parsing the contents of files.

» lterating over a list of things looking for something.

*  Searching for something on the file system.

e lterating over the menus already added to the context menu and trying to rename
them or remove them.

2.4.2.4 How to Add Menu Items to an Existing JDeveloper Menu

Sometimes, a feature of your extension can be handled simply by adding an item, or a
group of items, to an existing JDeveloper menu or toolbar.
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To add menus:

1. To add a new context menu in a window, editor, or explorer (such as the Structures
window) install listeners, as shown in the following example:

<cont ext - menu- hook rul e="al ways- enabl ed">
<site idref="navigator, editor, explorer"/>
<menu>
<I-- "weight' is used to control where the section appears in
the menu. Weights are sorted in ascending order, each unique
value is its own section. -->
<I-- section el ement nust be in namespace
http://jcp.org/jsr/ 198/ extension-manifest. -->
<section xm ns="http://jcp.orgljsr/198/extension-manifest"
i d="MY_CUSTOM MENU_SECTI ON_ONE" wei ght="1.0">
<l-- For nmenu items and subnenus, weight determnes the
order within a menu section. Items are sorted in ascending
order or in the order they are added if the weight is not
uni que. -->
<itemaction-ref="oracle.ide.extsanples.first.invokeAction"></iten»
</ section>
</ menu>
</ cont ext - menu- hook>

2. To add a menu to an existing menubar, see the following example:

<menu- hook xm ns="http://jcp.org/jsr/ 198/ extension-nanifest">
<menus>
<menubar id="javax.ide.view. MAI N_W NDOW MENUBAR_| D" >
<menu i d="My_CUSTOM MENU" wei ght ="20. 0" >
<l abel >${ TRANSLATED MENU_LABEL}<\ | abel >
</ menu>
</ menubar >
</ menus>

3. To add a menu item to a menu, see the following example:

<menu- hook xm ns="http://jcp.org/jsr/ 198/ extension-nanifest">
<l--
Add the action in its own separator group at the top of the File nmenu
-->
<menus>
<nenubar id="javax.ide.view. MAIN W NDON MENUBAR | D" >
<menu id="javax.ide. FILE_MENU | D'>
<section id="esdksanpl e. cust onsection" weight="1.0">
<itemaction-ref="oracl e.ide. extsanples.first.invokeAction"></
item
</ section>
</ menu>
</ menubar >
</ menus>

2.4.2.5 How to Add a Drop-down Button to a Toolbar

In some cases, your extension will operate through a window which may itself have a
toolbar with specific options unique to your extension, or to the specific data object
viewed in your extension's window. For more information, see How to Invoke an Addin
From a Main Window Menu.

To add a drop-down button to a toolbar:
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The code in the subsequent example, when included as a method to a window unique
to your extension, adds a drop-down button, with three actions, to a toolbar. When the
user clicks the button, the menu that appears contains three actions.

voi d doit(Tool bar tool bar, |deAction dropDownldeAction, |deAction ideActionl,
I deAction ideAction2, ldeAction ideAction3) {
Acti onMenuTool Button actionMenuTool Button =
t ool bar. addAct i onMenuBut t on( dr opDownl deActi on) ;
Action[] actions = new Action[] {
i deActionl,
i deAction2,
i deAction3,
b
acti onMenuTool Butt on. set MenuAct i ons(acti ons);

}

2.4.3 Working with Windows and Views

The JDeveloper data model uses two important concepts for displaying and monitoring
the content of the information you are working with: windows and views. Windows
(often dockable windows, which occupy a specific location in the IDE framework)
display information and take command inputs. Views define how JDeveloper accesses
the information objects (such as files or database records) that your extension
generates, manipulates or displays.

2.4.3.1 Understanding Dockable Windows

Dockable windows allow you to create a dedicated area for your extension at a
specified location in JDeveloper. Using dockable windows involves two key steps:

1. Creating a dockable window.
2. Positioning a dockable window.

Once you have created and positioned the window to be used by your extension, you
need to make sure that your extension is aware of that window, and in particular, that it
is aware when the user has selected your window for input. The mechanism that
JDeveloper uses for this is the IDE listener. Adding an IDE listener to your window
connects your extension to the window you created. For more information, see How to
Add an IDE Listener to a View.

Now that you have created, positioned, and assigned an IDE listener to your dockable
window, you are ready to make sure that your extension is aware when the user has
selected it. When a window is selected, it has the active view. You can now instruct
the IDE listener you added to listen for the active view. For more information, see How
to Listen for the Active View.

2.4.3.2 How to Create Simple Dockable Windows

ORACLE

Creating a dockable window involves three steps: creating a Dockabl eFact ory, creating
a dockable window using the class MyDockabl eW ndow, and then installing the
Dockabl eFact ory during the addin initialization.

To create a dockable window:

1. Create a Dockabl eFact ory, as shown in the following example:
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public class MyDockabl eFactory inplenents Dockabl eFactory
{
static final String VIEWTYPE = "M _VI EW TYPE";
public void install()
{
final Docki ngParam docki ngParam = new Docki ngParan() ;
docki ngParam set Posi tion(1deConstants. SOUTH);
DocksSt at i on. get DockStati on(). dock(
new MyDockabl eW ndow(),
docki ngParam ;
}
publ i c Dockabl e get Dockabl e(Viewl d view d)
{
if (viewd.getNanme().equal s(M/Dockabl eW ndow. VIEW I D))
return new MyDockabl eW ndow();
{

}
}

2. Create a Dockabl eW ndow, as shown in the following example:

return nul l;

public class MyDockabl eW ndow ext ends Dockabl eW ndow
{
static final String VIEWID = "MW _VIEWID";
private JlLabel _ui;
public MyDockabl eW ndow()

{
super (MyDockabl eFactory. IEWTYPE + "." + VIEWID);
}
public String getTabName()
{
return "ShortNane";
}
public String getTitleNane()
{
return "The Long Name Cones Here";
}
public String getTitleNane()
{
return "The Long Name Cones Here";
}
public Conponent get GUI ()
{
if (_ui ==null)
{
_ui = new JLabel ("The U is here");
}
return _ui;
}
public int getDefaultVisibility(Layout |ayout)
{
return DEFAULT_VI SIBILITY_VI SI BLE;
}
}

3. Install the factory during the addin initialization, as shown in the following example:

DockSt ati on. get DockStati on() . regi st er Dockabl eFact or y(
MyDockabl eFact ory. VI EW TYPE,
new MyDockabl eFact ory()

)s
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2.4.3.3 How to Position Dockable Windows

The following example shows how to center a dockable window with the Applications
window. If the Applications window extension is not loaded, the window will be docked
on the left (WEST).

docki ngParam = new Docki ngPar am() ;
final NavigatorManager applicationNavi gatorManager =
Navi gat or Manager . get Appl i cat i onNavi gat or Manager () ;
final Navigator Wndow navi gat or W ndow =
appl i cati onNavi gat or Manager . get Navi gat or W ndow( ) ;
docki ngPar am set Posi ti on(

navi gat or W ndow,

| deConst ant s. CENTER,

| deConst ant s. WEST

)s
2.4.3.4 How to Add an IDE Listener to a View

To add a selection listener to the active view, you need to listen for the active view
changes. If you added your listener to the view becoming inactive, you need to remove
your listener from that view.

To add an active listener:
Create code based on the following example:

i mport oracle.ide.view ActiveVi ewLi stener;

i mport oracle.ide.view ActiveVi ewEvent;

i mport oracle.ide.view ViewSel ectionLi stener;

class MyActiveViewlistener inplenents ActiveViewlistener

{
private ViewSel ectionListener _selectionListener = new Vi ewSel ectionLi stener()
{
public void viewSel ectionChanged(Vi enSel ecti onEvent e)
/1 Your code responding to view sel ection changes goes here.
{
|3

To change the active listener:
Create code based on the following example:

public void activeVi ewChanged( ActiveVi ewEvent e)

{
Viewview = e.getAdView);

if (view!= null) view removeViewListener(_sel ectionListener);

view = e. get Newvi ew() ;

[/\Wile this exanple adds a ViewSel ectionListener to any active view,
/lit is strongly recommended that you add your view selection |istener
//to views your extension is interested in only.

vi ew. addVi ewLi st ener (_sel ecti onLi stener);
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2.4.3.5 How to Listen for the Active View

The JDeveloper IDE architecture's model/view/controller model requires that your
extension keep track of which view—that is, which representation of the data is being
displayed in a given window—is active. (You may be familiar with windowing systems
that refer to active views as having input focus.) The JDeveloper IDE architecture
requires your extension to listen for the active view, as a way of ensuring that
commands executed by the view are applied to the appropriate data.

To listen for the active view:
Create code based on the following example:

| de. get Mai nW ndow() . addAct i veVi ewLi st ener (new Acti veVi ewLi st ener ()
{
public void activeVi enChanged(ActiveVi ewEvent e)
{
final View view = e.get Newiew);
Systemout. printIn(view getld() + " has been activated");
}
oK

2.4.4 How to Develop Wizards

A wizard is an extension that is invoked to perform some task. A typical wizard is
invoked through the Ul to open a user interface consisting of one or a sequence of
dialog boxes, in which the user specifies task parameters. A typical task is the creation
of a document or other data object. Specialized invocation mechanisms are provided
for wizards that are installed in the New Gallery or the Tools menu. In these cases
the Wizard Manager manages the invocation details.

2.4.4.1 How to Set Up a Wizard Project

ORACLE

The wizard project's properties specify paths, libraries, and other settings for the
wizard project. When you have set up your project you can add your source files to it,
and then debug and deploy your wizard.

A wizard project usually has three main components:

e Awizard class. This class deals with the wizard's appearance in the user interface,
and with its invocation. This class must implement the W zard interface.

A modal dialog. The dialog interacts with the user to collect data required for the
function of the wizard.

* A data object. The wizard applies the data collected by the dialog to create or
modify a data object.

Hel | oX, @ sample project, available as part of the Extension SDK implements wizard
directly and uses a JDialog as its user interface. Wizards that conform to JDeveloper's
look and feel use the JEWT wizard framework.

For more information about the Extension SDK, see Developing with the Extension
SDK ..
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2.4.4.2 How to Implement the Wizard Interface

Extensions that are to be invoked from the user interface to perform some modal task
should implement the or acl e. i de. wi zar d. W zar d interface. This interface provides for
the extension's installation, and integrates it with JDeveloper's user interface.

To Implement the wizard interface:

»  Define the i nvoke method
e Define the get | con method
» Define the wizard in the extension manifest

This method embodies the wizard's functionality. Wizards generally open a dialog to
obtain parameters from the user, and then use those parameters to create or modify a
document or other data object.

This method is called when the wizard's Ul element is selected by the user through the
New Gallery or Tools menu. The context parameter identifies the currently selected
objects that the wizard might affect.

To define the invoke method:
Create code based on the following example:

public bool ean invoke(Context ctx) {
if (lisAvailable(ctx))
return fal se;
String greetee = null;
greetee =
JOpti onPane. show nput Di al og( | de. get Mai nWndow(), "Enter your nane:",
W ZARD_NAME,
JOpt i onPane. OK_CANCEL_OPTION) ; ]
if (greetee == null) // User canceled
return fal se;
JOpt i onPane. showMessageDi al og( | de. get Mai nW ndow( ),
"Hello " + greetee + "!", WZARD NAME,
JOpt i onPane. | NFORMATI ON_MESSAGE) ;
return true;

}

This method is called to obtain the wizard's New Gallery or Tools menu icon. If the
wizard does not require an icon, this method should return nul | .

To define the getlcon method:
Create code based on the following example:
public Icon getlcon() {
if(imge == null) {

i mge = new | magel con( Hel | oX. cl ass. get Resour ce( | CON_NAME) ) ;
}

return image;
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2.4.4.3 How to Add a Wizard to the New Gallery

ORACLE

Wizards can be installed in the New Gallery by including a gallery wizard description
for them in the extension manifest file. All of the details of wizard registration and event
processing are handled by the Wizard Manager.

If the wizard is to be invoked only from the New Gallery, the constructor for the wizard
class is not called until the extension user first opens its category. The Gallery
Manager reads the description file when the category is first opened, and then
instantiates the wizard and constructs the item using the icon and label derived from
the instance.

There are a number of things that you define in the extension manifest. See the
following example:

<trigger-hooks xmns="http://xn ns.oracl e. conli de/ ext ensi on">
<triggers>
<gal lery xm ns="http://xm ns. oracl e. conf j devel oper/ 1013/ ext ensi on">

<fol ders>
<nane | abel ="ESDK- Gal | ery Exanpl e">ESDK- Gal | ery Exanpl e</ nane>
<cat egor y>CGener al </ cat egor y>

</fol ders>

<itemrul e="al ways- enabl ed">
<I-- name is the fully-qualified name of an oracle.ide.w zard.|nvokabl e

<nane>or acl e. i de. ext sanpl es. hel | ox. Hel | oX</ name>
<l-- idis optional, and if specified will be stored in the Context
so it can be retrieved when the wi zard is invoked. -->
<id>oracl e. i de. ext sanpl es. hel | ox</i d>
<l-- description is the short label of the gallery item-->
<description>Say Hel | o W zard</description>
<I-- help is the long label for the gallery item-->
<hel p>Pronpts the user to enter his nane, and repeats it. Part of the
Extension SDK, this is a trivial exanple.</help>
<i con>/ oracl e/ i de/ ext sanpl es/ hel | ox/ Hel | oX. gi f </i con>
<cat egor y>Cener al </ cat egor y>
<f ol der >ESDK- Gal | ery Exanpl e</fol der>
<litemp
</gall ery>
</triggers>
</trigger-hooks>

<gal | ery> contains the information about the wizard in the New Gallery.

e <nanme> defines the human-readable name for the wizard.

e <category> specifies the New Gallery category for the wizard. Within the category,
entries are alphabetical.

» <fol der > specifies the folder in the category.

* rul e in specifies when the wizard is available.

* The wizard class is identified in <i d>.

e <description> is the short description of the wizard in the New Gallery.

<hel p> is the long description for the entry displayed when the item is selected, or
when Show All Descriptions in the New Gallery is selected.

e <icon> specifies the icon in the New Gallery.
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By running the extension application, ext ensi onsdk, you can see how the code in the
previous example affects what is shown in the New Gallery, see

Figure 2-4 HelloX Wizard in New Gallery
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2.4.5 How to Develop Commands

An extension that adds a user-interface element such as menu item or toolbar icon, or
customizes an existing element for a new purpose, should encapsulate the
functionality in a command extension.

2.4.5.1 How to Implement the Addin Interface

Most extensions should implement the Addi n interface. This interface provides for the
extensions installation at the time of JDeveloper's startup.

To implement the Addi n interface, first define the constructor. The constructor should
do as little as possible; defer initialization tasks to the initialize method.

Then, define the ini tial i ze method. This method is called by the Addin Manager after
the instance has been created. The tasks that should be performed at initialization are:

e creation of Ul elements and controllers.
* Registration with managers.

Other tasks, such as the creation of data structures that are not needed until and if the
addin is invoked, should be deferred, so that JDeveloper's startup is not unnecessarily
delayed.

2.4.5.2 How to Implement a Command

ORACLE

If your extension adds a menu item or toolbar icon, you should implement its
functionality as a command.

An extension that defines specialized behavior for an existing control should use the
action and command class already provided for it, rather than define a custom action
or implement a custom command class. Fields defined in the | de class give the class
names and IDs of the IDE's standard commands.

A command for an extension involves these tasks:

« Handling the event

e Defining the undo method
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» Defining other methods

The code examples in this section are taken from the Fi r st Sanpl e sample project,
available as part of the Extension SDK. For more information, see Developing with the
Extension SDK ..

2.4.5.2.1 Handling the Event

The code in the following example shows how to handle the event, which is triggered
when you invoke the command.
/**
* Cont ext MenuLi steners add itens to context nenus.
*|
public final class SinpleContextMenuListener inplenments ContextMenulistener {
public void menuW | Show( Cont ext Menu cont ext Menu) {
/1 First, retrieve our action using the ID we specified in the
/1 extension manifest.
I deAction action = | deAction.find(SinpleController. SAVPLE CMD_ID);
[/ Then add it to the context menu.
cont ext Menu. add( cont ext Menu. creat eMenul t en(action));

publ i c bool ean handl eDef aul t Acti on( Cont ext context) {
/1 You can inplement this method if you want to handle the default

/1 action (usually double click) for some context.
return fal se;

}

For long blocks of code, you can use the dol t method.

2.4.5.2.2 How to Define the undo Method

This method must be defined only if the constructor specifies that the controller is of
the NORMAL type. The undo method generally has two tasks:

» Undo the doit methods effect by restoring a checkpointed state with the value
obtained from the get Dat a method, or by performing the inverse of the doi t
method's operation.

* Notify observers that the modification has taken place.

Return X if the command is successful, or CANCEL or some other non-zero value if not.
The default implementation returns CANCEL and has no side-effects.

2.4.5.2.3 How to Define Other Methods

ORACLE

These methods' default implementations can be overridden:

e getld returns the command ID passed to the constructor.

e get Type returns the "command type" constant passed to the constructor, or
NO_CHANGE if this argument was not given.

e get Nane returns the name string passed to the constructor, or the empty string if
this argument was not given.

*  get Affect edNodes returns nul | by default.

e setContext and get Context respectively write and read a protected Cont ext variable.
The default value is nul | .
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* setData and get Dat a respectively write and read a private Obj ect variable. The
default value is nul I .

2.4.5.3 How to Define an Action

An extension that implements new command classes should define actions to contain
them. An action serves as the link between a menu item, or other user-interface
control, and the command that is executed when the menu item is selected. Actions
are instances of | deAct i on.

An extension that defines specialized behavior for an existing Ul element should use
the action already provided for it, rather than define a custom action. Fields defined in
the I de class give the class names and IDs of the standard commands. For example,
any editor that provides a 'save' operation should use the predefined | de. SAVE_CMD and
| de. CUT_SAVE_| D values and the action that is associated with them.

Actions are typically defined as fields of the Addin class that installs the menu items or
toolbar icons they are associated with. Create and configure actions as part of the
extension's initialization.

The code examples in this section are taken from the Fi r st Sanpl e sample project,
available as part of the Extension SDK. For more information, see Developing with the
Extension SDK .

2.4.5.3.1 How to Obtain an Action

Actions are cached by command ID. If an action already exists for the command you
require, you should generally use it instead of creating a new one.

Do not use the | deActi on contstructors to create actions. Instead, use the following
static methods to retrieve a cached action or create a new one:

* The find method returns an action that contains the given command id, if one has
already been cached.

e The various get methods return the action matching the given command id, if such
an action has been cached, but the properties of this action may or may not match
the parameters given. If no action is found for the command ID a new action is
created from the given parameters, cached, and returned.

* The creat e methods create and return a new action without caching it. A action
obtained from create is not available to subsequently loaded extensions.

2.4.5.3.2 How to Set Action Values

An action may have various properties, such as those that determine appearance,
which are accessed through string keys by the put val ue and get val ue methods. Some
of the properties are set when an action is created by a create or get static method.
Keys recognized by the IDE are defined in the ToggleAction superclass. For more
information, see Toggl eActi on in the Java API Reference for Oracle Extension SDK.

2.4.5.3.3 How to Extend an Action's Controller

An action that is independent of a view, such as 'open’, must specify a controller to
update the action and handle its events. An action that is invoked in the context of a
view need not have an action controller.
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The behavior of a command, for all IDE features that use that command, can be
extended to perform some custom operation by replacing the controller of the
command's action, or by giving the action a controller if it did not already have one.
However, care must be taken to avoid disrupting default behavior.

To replace an existing controller:

1. Implement the new controller class by extending the old class.

2. In the new controller's handling of the command that is to be extended, perform
the cust omoperation, and then invoke the old controller's handl eEvent method for
the command, so that the original behavior is preserved.

To add a controller to an action that does not have one:

1. Implement a new controller class.

2. In the new controller's handling of the command that is to be extended, perform
the cust omoperation, and then invoke the supervisor's handl eEvent method for the
command, so that the original behavior is preserved.

Use the get Control | er and addControl | er methods to access an action's controller.

2.4.5.3.4 Extending an Action's Command Class

The get Command method returns the name of the action's command class. The

set Command method can be used to replace it. However, doing so replaces it globally,
affecting all IDE features that handle the action. To avoid unwanted side effects,
replace an original command class only with a class that extends it.

2.4.5.4 How to Invoke an Addin From a Main Window Menu

To allow an addin to be invoked from a main window menu, add a menu item for it to
one of the main window menus. The item can be added to any menu, however, if the
extension is to be invoked from the Tools menu, it should be installed as a wizard,
rather than (or in addition to) being installed as an addin: the Wizard Manager takes
care of the details of adding and handling menu item in the Tools menu.

The IDE menus are represented by a singleton instance of Menubar , which can be
accessed using the get Menubar method.

Extensions can add menus, submenus, and menu items to the IDE menus. Extensions
that are invoked, such as wizards, add their own items to menus when they are
installed. Alternatively, extensions can define their own behavior for standard menu
items. For example, effect of the items in the Edit menu depend on the editor in use.

2.4.5.5 How to Invoke an Addin From a Context Menu

ORACLE

Some views, such as the Applications window and the source editor have context
menus that pop-up when the user right-clicks in the window. Extensions can add items
to context menus.

When the user right-clicks, the context menu is reconstructed. Selected context menu
listeners — those associated with the subject of the right-click — are polled, and given
the opportunity to contribute items or submenus to the context menu. For example,
when a node representing a document is right-clicked, editors and designers that are
registered as viewers for that document's type are allowed to add their menu items to
the context menu.
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The following example shows how to install context menus in a window such as the
Applications window. The code is taken from the ClassBrowser project in the
extension samples that are installed as part of the Oracle IDE Extension SDK.

<l--
Install context nenus in the navigator, editor
whi ch use the sane action defined above. -->

<cont ext - menu- hook rul e="al ways- enabl ed" >
<site idref="navigator,editor"/>
<menu>
<I-- "weight' is used to control where the section appears in
the menu. Weights are sorted in ascending order, each unique
value is its own section. -->
<l-- section element nust be in namespace
http://jcp.org/jsr/198/ extensi on-manifest. -->
<section xm ns="http://jcp.org/jsr/ 198/ extensi on-manifest"
i d="MY_CUSTOM MENU_SECTI ON_ONE" wei ght =" 1. 0">
<l-- For menu items and submenus, weight determines the
order within a nenu section. Itens are sorted in ascending
order or in the order they are added if the weight is not

uni que. -->
<item action-ref="esdksanpl e. showd assBrowser"></itenp
</ section>
</ menu>

</ cont ext - menu- hook>

2.4.6 How to Develop Editors

An editor is a view that displays an object for the user to modify. Editors usually
display text; a designer is a non-textual editor. Editors are opened for a document
through its node's context menu or the View menu. The editors available for a
document are those registered for the document's type with the IDE's Editor Manager.
Editors are usually used in conjunction with structure explorers, but this is not required.

The Cust onEdi t or project in the Extension SDK illustrates how to do this by
implementing a custom XM_Quer yEdi t or which extends oracl e. i de. edi tor. Edi tor and
implements j ava. beans. Propert yChangeLi st ener. For more information, see Developing
with the Extension SDK .

2.4.6.1 Using Asynchronous Editors

ORACLE

An asynchronous editor loads its contents in a worker thread, outside the Ul thread
(event dispatch thread in Swing,) resulting in a more responsive user experience.
While loading the contents of an asynchronous editor, the editor framework:

e Shows a panel with the message "Loading Editor" and an animation. Both of these
are configurable.

e Prevents the Components window from loading and blocking the UI.

Loading of the editor starts when a Cont ext is set. This action triggers loading of the
model that the editor's Ul needs from the Ul thread. To do so, an asynchronous editor
creates a worker thread to perform the loading. While the model loading is taking
place, the IDE asks the editor for its GUI component. If the editor's real Ul is not
loaded yet, a panel with a message (for example, "Loading Editor") appears and the
Components window is not loaded. Once the editor's real Ul is created, the
asynchronous editor automatically swaps it.
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The editor framework gives a lot of freedom as to how editors can be implemented.
For more information, see AsynchronousEdi t or in Java API Reference for Oracle
Extension SDK.

2.4.6.1.1 How Asynchronous Editors Work

The first step is that Edi t or Manager creates and opens the editor, for example when a
user double-clicks a node in the Applications window:

1. EditorState creates a new asynchronous editor (a subclass of
oracl e.ide. editor. AsynchronousEditor.)

2. When the asynchronous editor is created, it sets a property that lets other views in
the IDE know that it is an asynchronous editor and the "real" editor is not loaded
yet. An example of a view interested in this property is the Components window.
The Components window only loads its contents once the editor is fully loaded.

3. EditorState sets the Context in the new asynchronous editor.

4. The asynchronous editor waits for the appropriate flags indicating that its contents
are not loaded yet before loading the asynchronous editor content model. This is
done asynchronously (off the Ul event thread.)

5. EditorManager sets the preferred layout for the editor
6. EditorState opens the editor, which eventually causes a call to get GUI .

This is illustrated in Figure 2-5.

Figure 2-5 Opening the Editor

1. openEditor

7. initPreferredLayout

2. createEditor

EditorManager

: 11. Fire "editor opened” event

EditorState

8. open 3. <<create>>

AsynchronousEditor

9. openImpl
y

10. If content available,
implementations can load necessary libraries, etc.

<<trues >
5. Issame Node?
Node already loaded

Go to step 7

<< falsex >

CS. Get ready for bading content asynchmnousID

Once the editor is open. the editor's method get QU is called. This is the moment that
asynchronous editors show a "loading editor" message, while scheduling a task off the
Ul event thread to load the content model asynchronously, as illustrated in Figure 2-6.
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Figure 2-6 Getting the Editor's GUI

1. openEditor
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G. Get ready for loading content asynchmnousID

At this point, the content model has been loaded asynchronously, and:

e AsynchronousEdi t or calls the methods openl npl, show npl and acti vat el npl , to load
the editor's GUI, show it, and activate it.

e AsynchronousEdi t or switches the "waiting" page with the "real" editor GUI

e AsynchronousEdi t or notifies listeners such as the Components window that it is fully
loaded, so they can load their respective contents.

To make a regular editor an asynchronous editor:

1. Extendoracle.ide. editor.AsynchronousEditor instead of oracl e. i de. editor. Editor.

2. Implement the abstract method get Edi t or Cont ext (Cont ext) . This method is the
responsible of loading the model that the editor's Ul needs from the given Cont ext .

3. Implement the abstract method doSet Cont ext ( Cont ext ) . This method is expected to
have the same functionality as the original method set Cont ext (Cont ext) in Editor .
set Cont ext (Cont ext) is now final (to guarantee correct behavior of asynchronous
functionality.)

4. Implement the abstract method i sCont ent Mbdel Loaded() . This method indicates the
asynchronous editor framework if the model used by your editor is loaded or not.

5. Implement the abstract method openl npl (bool ean) . To ensure correct behavior of
asynchronous editors, the abstract method open() in Edi t or is now final. openl npl
passes a boolean argument that indicates whether the model for the editor's Ul
has been loaded or not. In most cases, you would only need to move your existing
implementation of open() to openl npl when the given argument is true.

6. Move all the code in the Edi t or lifecycle events to the new methods. To guarantee
that asynchronous content loading works correctly, Asynchr onousEdi t or makes the
editor life-cycle final, giving subclasses implement them through "i npl " methods.

The life-cycle methods made final are:
° open

e close
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e editorShown

e editorH dden

* activate

e deactivate

Subclasses of AsynchronousEditor need to implement these methods instead:
e openl mpl (bool ean)

* closel npl (bool ean)

e editorShownl npl (bool ean)
e editorHi ddenl npl (bool ean)
° activatelnpl (bool ean)

* deactivatel npl (bool ean)

where the boolean argument specifies whether the content model of the editor has
been loaded or not.

The complexity of this task is related to the number levels in the class hierarchy for
a specific editor, especially when overriding life-cycle methods. If a chain of
classes override cl ose(), now all of them need to override cl osel npl (bool ean)
instead.

2.4.7 How to Develop Explorers

A structure explorer displays the organization of a document, usually as a tree.
JDeveloper provides explorers for various common document types, and allows
custom explorers to be installed and registered with the Explorer Manager.

2.4.7.1 How to Create an Explorer

ORACLE

A structure explorer displays the organization of a document, usually as a tree.

A structure explorer is a Vi ew of a Docunent . When an editor or designer is given focus,
its explorer is shown in the structure window. An explorer is essentially an index or
table of contents for the document: the user uses the explorer to navigate in the
content displayed in the document view. The hierarchy of the document is displayed in
the Structure window, and is updated as the document is edited.

JDeveloper provides explorers for various common document types, and allows

custom explorers to be installed and registered with the Explorer Manager. When a
document is opened in JDeveloper, the Explorer Manager provides an appropriate
explorer for it, which then parses the document and displays the resulting structure.

An explorer addin has the following components:

* A class that performs the registration. This class implements Addi n. A single
instance of this class is created by the addin manager when JDeveloper is
launched, and that instance performs the registration. The addin class does not
need to have any other purpose.

» Aclass that provides the explorer's user interface. This class is a specialized
viewer. When the document's structure is to be represented by a tree most of the
required functionality can be provided by extending TreeExpl orer or one of its
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subclasses. This class handles mouse clicks on elements, tracks changes in the
editor, and invokes the parser to rebuild the tree when necessary.

*  An element model, which contains one or more instances of El ement. The model is
the structural representation of the explorer view of a document. Elements are
associated with specific locations in the content of the document, and when
selected, scroll the viewer to that location.

e A parser that generates a structure of elements from the document. The parser
reduces the document to a hierarchy of elements which map to viewer
coordinates.

Keep these facts in mind while designing your explorer:

* An Explorer is a view which provides a visual, structured, representation of the
data contained in a Docunent .

*  Multiple explorer implementations may exist for a single document.
* Implement the Expl orer interface to create a structure explorer.

e ChildFilter is an optional interface to use in conjunction with TreeExpl orer to filter
which children of a given container node are made visible to the user when the
user expands that container node.

2.4.7.2 How to Register and Initialize a Structure Explorer

Explorers must be registered with the IDE's Expl or er Manager . Registration associates
an explorer with a node class, or with a node/viewer pair.

When the user selects a viewer for a node, the IDE sends a request to the

Expl or er Manager for the explorer that best satisfies that node and viewer. The resulting
viewer will be one registered for that node and viewer, or else one registered for the
node alone. If no such registrations have been made, ExplorerManager tries to find a
viewer that is registered for a node class that converts to the requested node class.

Registration operations should be performed in an addin class' initialize method, as

shown in the following example. The code example is taken from the StructurePane
project, one of the sample projects available as part of the Extension SDK. For more
information, see Developing with the Extension SDK .

public void initialize()
{
Class editorC ass = PropFil eEditor.class;
Expl or er Manager . get Expl or er Manager () . regi st er (PropFi | eSour ceNode. ¢l ass,
PropFi | eExpl orer. cl ass,
PropFil eEditor.class );

}

2.4.7.3 How to Create a Structure Explorer Element Model

ORACLE

The element model of an Explorer is the structural representation, illustrated
graphically, of data in a given Document.

Each model is made up of one or more instances of El enent . The model is typically
rendered visually in the Explorer as a tree, but this is not a requirement. The element
model is not a visual object, but can be rendered visually using graphical controls, for
example, j avax. swi ng. tree. TreeMbdel rendered by j avax. swi ng. JTr ee.
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Implementations of Explorer are responsible for ensuring that their model, and by
extension their visual representation of that model, receive changes made to the data
in the Document by any method (for example, in the source editor, Property Inspector,
hand editing of the document outside of JDeveloper). You can use the JDeveloper
event messaging mechanism to achieve this.

2.4.7.4 How to Update the Structure Explorer

A structure explorer should be notified whenever the content of the of the associated
document is modified, so that it can update its state. Use the notification mechanism to
transmit information about changes in the viewer to the explorer. The structure
explorer should implement Cbser ver, providing an update method, and register with the
object representing the viewer's document.

2.4.8 How to Add New Components Window Pages

The Component Manager lets you add individual pages to the Components window
that users of your extension can employ to build a consistent user interface or perform
other standardized tasks. The Components window provides pages of components,
from which your users can select the components to add to the content they are
building with your extension, or for your extension.

The ability to create and manage component pages is also available programmatically,
through the methods of the Pal et t eManager instance. For more information, see
Pal et t eManager in the Java API Reference for Oracle Extension SDK.

This section includes examples for declaratively adding static and dynamic
components to your Components window, as well as providing additional help and
augmenting the user's ability to search for specific items in your individual component
pages.

2.4.8.1 Understanding Components Window Pages

ORACLE

The Components window lets users add commonly used data structures to a project,
application, or other content in JDeveloper. The Components window provides pages,
from which users can select individual components to add to the content they are
building with or for your extension. The specific components can be as simple as a
copyright statement or as complicated as the settings for connecting to a remote
repository. Furthermore, in JDeveloper, the available components from any given
Components window page varies depending on the type of file selected. For example,
if you are editing an HTML file, the Components window page might display a list of
available HTML components such as anchors, email links, and other commonly-used
HTML components. If you are editing a Java page, a completely different set of
components are at your disposal.

To see the Components window, select View > Components.

At the extension developer's level, the Components window provides you with a
declarative way to add pages to the Components window, to make specific
components available to users of your extension. These pages can offer whatever
standard components (both static and dynamic) you wish to provide. For example, to
help your users build a consistent user interface, or to perform any standardized tasks
that draw on the components maintained by JDeveloper's Components manager, you
can add one or more pages of components to the Components window, using the
Component Manager.
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When you develop extensions, you can declaratively populate your extension with
component pages, static and dynamic components, and support for them. You can:

» Declare static components on a Components window.

e Declare dynamic components, populating the Components window when it is
loaded.

» Help make your components available to your users.
* Make it easier for users to search for your components.

If you use these declarative tools, users of your extension can add commonly used
elements to their own projects and applications using the extension you are creating.
In addition, the help and search features makes it easier for your users to find and
apply these Components window components.

You can also add component pages programmatically, using the Components
Manager.

2.4.8.2 How to Declare Static Content for a Components Window

In many cases, the Components window's content is constant: a set of connection
parameters to a source repository, or other fixed data that does not change regardless
of where it is used in your extension. For cases like this, you can define static content
in an extension manifest file, using pal et t e- hook, as shown in the subsequent
example.

The shape of the Components window is defined as a simple four-tier taxonomy:

* The top level, referred to as Page, groups components according to technology;
Swing, AWT, ADF Swing, ADF Faces, Java Server Faces (JSF), JavaServer
Pages (JSP), and so on. The combo box selections at the top of the Components
window are where Pages display in the Ul.

*  Within each Page are Groups. Groups contain a small number of functional
categories. For example, page Swing may have groups Common Controls and
Layout. Groups are the dockable windows within the Components window.

*  Within each Group are Sections, sections provide the means to cluster common
components, display a separator line in the Ul similar to menu separators, and
alphabetically sort components by name.

*  Finally, within each Section are Items (or components). Items are made up of
attributes that enable components to be displayed by the Components window, for
example name, description, icon, etc.

The following example, which is taken from the CPPagePr ovi der project in the Extension
SDK, demonstrates how to declare a Components window page with a single
component. For more information about the Extension SDK, see Developing with the
Extension SDK .

<?xm version="1.0" encodi ng="UTF-8" ?>
<extension xm ns="http://jcp.org/jsr/ 198/ ext ensi on- mani f est"
i d="oracl e. i de. ext sanpl es. cppagepr ovi der "
version="11.1.1"
esdk-version="1.0">
<name>ESDK Sanpl e - Conponent Pal ette Page Provider</name>
<owner >Or acl e</ owner >
<feat ure-menber id="esdk-sanpl es"
xm ns="http://xm ns. oracl e. conf i de/ ext ensi on"/ >
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<hooks>
<pal ette-hook xm ns="http://xn ns.oracle. conljdevel oper/ 1013/ extensi on">
<pagePr ovi der >
<provi der O assName>or acl e. i de. ext sanpl es. pagepr ovi der . Sanpl ePagePr ovi der </
provi der
C assNane>
</ pageProvi der>
<page>
<name>Sanpl e Conponents (ESDK Sanpl ) </ name>
<pagel d>Sanpl eSt ati c</ pagel d>
<showFor Types>
<type>j ava</type>
</ showFor Types>
<t echnol ogyScopes>
<t echnol ogyScope>Java</t echnol ogyScope>
</t echnol ogyScopes>
<type>j ava</type>
<group>
<nane>Conponent s</ nane>
<groupl d>Sanpl eSt at i c- Conponent s</ gr oupl d>
<showFor Types>
<type>j ava</type>
</ showFor Types>
<t echnol ogyScopes>
<t echnol ogyScope>Java</t echnol ogyScope>
</t echnol ogyScopes>
<type>j ava</type>
<section>
<sectionl d>Sanpl eSt at i c- Conponent s- Secti onl</sectionl d>
<nane/ >
<itemp
<nane>Tabl e</ nane>
<descri pti on>Sanpl e Tabl e</descri ption>
<i con>${ Or acl el cons. TABLE} </i con>
<infol>
<t ype>JavaBean</type>
<i tenl d>Sanpl eSt at i c- Conponent s- Secti onl-Itentl</iten d>
<t echnol ogyScopes>
<t echnol ogyScope>Java</t echnol ogyScope>
</t echnol ogyScopes>
<litem
</ section>
</ group>
</ page>
</ pal et t e- hook>
<f eat ur e- hook>
<part-of >oracl e. i de. ext sanpl es. al | sanpl es</part - of >
<descri pti on>Denonstrates how to integrate a conponent pal ette page provider
into the |DE </description>
<optional >true</optional >
</ f eat ur e- hook>
</ hooks>
</ extensi on>

2.4.8.3 How to Declare a Dynamic Component for a Components Window
Page

At times, the content of a Components window cannot be identified before loading. For
the case when the Components window content can not be defined beforehand it is
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necessary to define a Components window Page Provider. This approach provides
considerable flexibility to client developers in that the Components window provides
the display context to the provider and the provider is given an opportunity to return
components to be displayed in the Components window.

Components window page providers are developed by client developers using the
published Components window APl and the page providers class name is provided to
the Components window in an extension manifest file.

For a description of the Components window API, see oracl e. i de. pal ette2 in the Java
API Reference for Oracle Extension SDK.

The extension manifest entry uses hook's el ement pagePr ovi der.

The following example shows an extension manifest that identifies a Components
window Page Provider class name.

<?xm version="1.0" encodi ng="w ndows- 1252" ?>
<extension xm ns="http://jcp.org/jsr/ 198/ ext ensi on- mani f est"”
i d="oracl e. i de. sanpl es. pagepr ovi der"
version="1.0"
esdk-version="1.0">
<nanme>Conponent Pal ette Page Provider Sanple</nane>
<owner >Or acl e</ owner >
<dependenci es>
<inport>oracl e.ide.pal ette2
</ dependenci es>
<hooks>
<pal ette-hook xm ns="http://xm ns. oracl e. conl j devel oper/ 1013/ ext ensi on">
<pageProvi der >
<provi der G assName>or acl e. i de. sanpl es. pagepr ovi der . Sanpl ePagePr ovi der </
provi der C assNane>
</ pagePr ovi der >
</ pal ett e- hook>
</ hooks>
</ extensi on>

The subsequent example shows a Components window Page Provider that adds a
Components window page to the Components window. This class extends
Pal et t ePagePr ovi der.

The element pageProvi der . provi der O assNane in ext ensi on. xnl registers this class with
the Components window as a page provider. The Components window calls
creat ePal et t ePages() with the current Context.

The class Sanpl ePages, which extends Pal et t ePages, is constructed with the current
context, means that it should have sufficient information to assemble a list of palette
pages when get Pages() is called by the Components window.

package oracle.ide. sanpl es. pageprovi der;

Sanpl ePageProvi der. j ava

import oracle.ide. Context;

inmport oracle.ide.palette2. Pal ettePageProvider;

import oracle.ide.pal ette2. Pal ettePages;

/**

* Sanpl ePageProvi der

* o<p>

* This is an exanple of a Pal ettePageProvider that adds a palette page to the
* Conponent Palette(CP). As required this class extends Pal ettePageProvider.
* </ p>

* o<p>
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El enent pageProvi der. provi der G assName in extension.xm registers

this class with the CP as a page provider.

</ p>

<p>

The CP will call nethod createPal ettePages() with the current Context.

Cl ass Sanpl ePages which extends Pal ettePages is constructed with the current

Using the current context Sanpl ePages shoul d have sufficient information to
assenmble a list of palette pages when method getPages() is called by the CP.
</ p>

@ee Sanpl ePages

@ee Sanpl ePal et t ePage
@ee Sanpl ePal etteG oup
@ee Sanpl ePal etteltem

public class Sanpl ePageProvi der extends Pal ettePageProvider {

/**

* Default constructor.

*

*/
public Sanpl ePageProvider () {
}

/**

* Qverride the default, returns Sanpl ePages if context applies.
*
* (@aram cont ext
* @eturn PalettePages if context is relevant, otherwise null.
*|
public Pal ettePages createPal ettePages(Context context) {
if ( checkRel evant Context( context ) ) {
Sanpl ePages pages = Sanpl ePages. get | nstance();
pages.initialize(context);
return pages;
}
el se
return null; // no pages to provide for this context.

}

The following example shows an instance of Sanpl ePages. j ava. This class creates a
Components window page with a single group that contains a single section that
contains a single item when the pageType is j ava. As required this class extends

Pal et t ePages.

package oracle.ide. sanpl es. pageprovi der;
i mport java.net.URL;
import java.util.Arraylist;
import java.util.Collection;
import java.util.Collections;
import java.util.List;
i mport oracle.ide. Context;
i mport oracle.ide.net.URLFi | eSystem
import oracle.ide.palette2. Defaul tPal etteSection;
import oracle.ide. palette2. Paletteltem
import oracle.ide.palette2. Pal ettePage;
import oracle.ide.pal ette2. Pal ettePages;
inport oracle.ide.palette2. Pal ettePagesLi stener;
/**
* Sanpl ePages
*o<p>
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* This class creates a palette page with a single group that contains a
* single section that contains a single itemwhen the pageType is "java".
* As required this class extends Pal ettePages.

* </ p>

* o<p>

* TODO pal ettePagesLi st ener

* </ p>

*

/
public class Sanpl ePages extends Pal ettePages {

private final static String SAMPLEPROVI DER | D
=Sanpl ePagePr ovi der. cl ass. get Nane() ;

/**

* Singleton

*/

private static Sanpl ePages _singleton = new Sanpl ePages();
/**

* Conposite for Pal ettePagesListener

*/

protected List<Pal ettePagesLi stener> pal ettePagesLi steners;
/**

* Conposite for Pal ettePage

*|

protected List<Pal ettePage> pal ettePages;
/1 Default constructor
public Sampl ePages() {
}
/**
* Returns the singleton instance of Sanpl ePages.
* @eturn the singleton instance of Sanpl ePages
*|
public static Sanpl ePages getlnstance() {
return _singleton;

}
/**
* Initialize palettePages.
* (@aram cont ext
*/
public void initialize(Context context) {
URL url = context.getNode().get URL();
final String pageType = getSuffix( url );
[/ Only interested in java.
i f( pageType.equal s("java") ) {
if( palettePages != null ) {
pal ettePages. clear();
}

Il create a Pal ettePage
Sanpl ePal et t ePage page = new Sanpl ePal et t ePage
"oracl e. i de. sanpl es. pagepr ovi der. SanpPage01" // pageld
, "My Sanpl e Page Conponent" // description

, null /] icon

, "java" Il type

, "java" /'l showFor Types

, "Java; JavaBeans" ); /'l technol ogyScope

Il create a Pal etteG oup
Sanpl ePal etteG oup group = new Sanpl ePal etteG oup
"oracl e. i de. sanpl es. pagepr ovi der. SanpG oup01" // groupld

, "My Sanple G oup" /] name
, "My Sanple Goup Conponent" // description
, "java' ), Il type

/1 add group to page
page. addG oup( gr oup) ;

ORACLE 2-35



ORACLE

Chapter 2
Creating JDeveloper Elements

Il create a section. Make the name null since a separator is not neeeded.
Def aul t Pal etteSection section = new Defaul t Pal etteSection
"oracl e. i de. sanpl es. pagepr ovi der. SanpSect i on01" // sectionld
/1 add section to group
group. addSecti on(section);
Il create an item TODO use Sanpl eBean.|java
Sanpl ePal etteltemitem = new Sanpl ePal etteltem
("oracle.ide.sanpl es. pageprovider. Sanpltend1" // itemd
, SAMPLEPROVIDER_ID // provider id
, "My Sanple Bean" Il nane
, "My Sanpl e Bean Description" [/ description
, "loraclelidelsanpl es/ pageprovi der/snapshot.png" // icon
, "java"); Il type
Il add itemto section
section.addlten{iten); // add itemto section
/1 add page
addPage( page) ;

el se {
pal ett ePages. cl ear () ;
}
}
/**
* get Pages
*|
public Collection<Pal ettePage> getPages() {
return Col | ections. unnodifi abl eLi st (pal ettePages);

—

Returns the Paletteltemidentified by itemd. provideridis usedto

determne whether this itemis owned by this page provider.

The provider returns the matching Paletteltemonly if the Paletteltem
iswthinthe current context. Null is returned if the Paletteltemis
within the current context or not recognized by this provider.

</ p>

@eturn Paletteltem

I

*/
public Paletteltemgetiten{ String providerid, String itemd ) {
if( providerld == null || providerld.length() ==
|| itemd ==null || itemd.length() == 0) {
return null;
}
Pal etteltempal etteltem= null;
i f( providerld.equal s(SAMPLEPROVIDER I D)) {
for( PalettePage pal ettePage : pal ettePages ) {
Sanpl ePal et t ePage sanpPage = (Sanpl ePal ett ePage) pal ettePag
pal etteltem = sanpPage. getlten(item d);
if( paletteltem!=null ) {
break;

}

} Il end of for
}

return paletteltem
}
/**
* addPal et t ePagesLi st ener
public void addPal ettePagesLi st ener (Pal ettePagesLi stener |istener) {

i f( palettePagesListeners == null ) {

pal ett ePagesLi steners = new ArrayLi st <Pal ett ePagesLi stener>();

}

pal et t ePagesLi st eners. add(|i stener)
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}
/*
* add pages to pal ettePages.
/*
private voi d addPage( Sanpl ePal ettePage sanpPage ) {

if (palettePages == null ) {
pal ettePages = new Arrayli st<Pal ettePage>();
1
pal et t ePages. add( sanpPage) ;
1
*/
* Return suffix
* @aramtitle Title of EditorFrame

*|

private String getSuffix( URL url )

(
final String suffix = URLFileSystemgetSuffix( url );
int period = suffix.lastlndexOr( "." );

if( period!=-1)

Il 1s a selected file
return suffix.substring( period + 1);

}

return "

}

The following example shows an instance of Sanpl ePal et t ePage. j ava.

package oracle.ide. sanpl es. pageprovi der;
import java.util.Arraylist;
import java.util.List;
inport java.util.StringTokenizer;
inmport oracle.ide.palette2. Defaul t Pal ettePage;
/**
* Sanpl ePal et t ePage
*o<p>
* This class extends Defaul tPal ettePage. Defaul tPal ettePage conprises
* the attributes and nethods that this exanple requires. A constructor is added
* to acconndate the data values for this sanple.
* </ p>
*/
public class Sanpl ePal ettePage extends Defaul t Pal ettePage {
public Sanpl ePal ettePage(String pageld, String pageName, String pageDescription
, String pagelcon, String pageType, String pageShowFor Types
, String pageTechnol ogyScope) {
set Nane( pageNane );
setDescription( pageDescription );
setlcon( pagelcon );
set Dat a( PAGE_PACEI D, pageld );
set Dat a( PAGE_TYPE, pageType);
/1 make delimted string into a List of strings
Li st<String> showror Types = new ArrayLi st<String>();

final StringTokenizer tknTypes = new StringTokenizer pageShowFor Types, ";" ); [/
NOTRANS

whi | e( tknTypes. hasMor eTokens() )

{

String token = (String)tknScopes. next Token();
t echnol ogyScope. add(t oken);

}
set Dat a( PAGE_TECHNOLOGYSCOPES, t echnol ogyScope );

ORACLE 2-37



Chapter 2
Creating JDeveloper Elements

}
}

package oracle.ide. sanpl es. pageprovi der;
import oracle.ide.palette2. Defaul tPal etteG oup;

/**

* Sanpl ePal ett eGr oup

* o<p>

* This sanpl e extends Defaul t Pal etteG oup. Defaul t Pal etteG oup conprises the

* attributes and nethods that this exanple requires. A constructor is added to
* accormpdate the data values for this sanple.

* </ p>

*

*

/
public class Sanpl ePal etteG oup extends Defaul tPal etteGoup {
public Sanmpl ePal etteGoup(String groupld, String groupName, String
groupDescription, String groupType) {
set Nane( groupName );
set Descri ption( groupDescription );
set Dat a( GROUP_GROUPI D, groupl d);
set Dat a( GROUP_TYPE, groupType);

}

The following example shows an instance of Sanpl ePal etteltem j ava.

package oracle.ide. sanpl es. pageprovi der;

import oracle.ide. palette2. DefaultPaletteltem

* Sanpl ePal etteltem

*o<p>

* This exanple extends Defaul tPaletteltem DefaultPaletteltem conprises

* the attributes and nethods that this exanple requires. A constructor is
* added to accommodate the data values for this sanple.

* </ p>

*

*/
public class Sanpl ePal etteltem extends Defaul tPal etteltem

public SanplePaletteltem(String itemd, String itenProviderld, String itenNane,
String itenmDescription,
String itemcon, String itenfype) {
set Nane( itemNanme );
set Description( itenDescription);
setlcon( itemcon );
setitemd( itemd );
set Provi der | d(itenProviderld);
set Dat a(| TEM TYPE, itenfype);
)
)

2.4.8.4 How to Provide Help for a Components Window Page

ORACLE

There are two ways to provide help on a component:

*  The Components window item description is displayed as a tool tip for the
component, visible when your user rolls the mouse over the component in the
Components window. You can use the "\n" newline character to break the
description into multiple lines.

e The user can right-click a Components window component and get help from its
context menu. The Help option appears on the context menu for the component
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only if a Helpable is available for the component. If the helpable class cannot be
instantiated, the string is used as the helpld for the IDE help system.

The following example demonstrates how to do this.

<item
<name>Tabl e</ name>
<descripti on>Sanpl e Tabl e</description>
<i con>/ oracl e/ i de/ sanpl es/ pagepr ovi der/ t abl e. png</i con
<infol>
<t ype>JavaBean</type>
<i tem d>Sanpl eSt ati c- Conponent s- Secti onl-1tenl</item d>
<t echnol ogyScopes>
<t echnol ogyScopes>
<t echnol ogyScope>JavaBeans</t echnol ogyScope>
</t echnol ogyScopes>
<hel pabl e>or acl e. sanpl es. Sanpl eHel pabl e</ hel pabl e>
<litem

Alternatively, you can provide the helpid directly, as shown in the following example:

<itemp
<nane>Tabl e</ nane>
<descri pti on>Sanpl e Tabl e</descri ption>
<i con>/ oracl e/ i de/ sanpl es/ pagepr ovi der/t abl e. png</i con>
<infol>
<t ype>JavaBean</type>
<i tenl d>Sanpl eSt at i c- Conponent s- Secti onl-Itent</item d>
<t echnol ogyScopes>
<t echnol ogyScope>Java</ t echnol ogyScope>
<t echnol ogyScope>JavaBeans</ t echnol ogyScope>
</t echnol ogyScopes>
<hel pabl e>hel p_t opi c_i d</ hel pabl e>
<litemp

The programmatic equivalent of this would be to implement get Hel pabl e() in the
Pal ett el t eminterface.

2.4.8.5 How to Augment the Search for a Components Window Item

ORACLE

By default, when the user types a word or phrase into the Components window search
box, JDeveloper looks for items that have the search string in their Name or
Description.

To make the Components window search on other embedded data that is not visible to
the user (such as tag attributes), a sear chText Cont ext can be provided along with the
item.

Declaratively, you indicate this in the Components window extension hook as shown in
the following example:

<item
<nane>Tabl e</ name>
<description>Sanpl e Tabl e</ descri ption>
<i con>/ oracl e/ i de/ sanpl es/ pagepr ovi der/ t abl e. png</i con>
<infol>
<t ype>JavaBean</type>
<i tenl d>Sanpl eSt ati c- Conponent s- Sectionl-Itenl</item d>
<t echnol ogyScopes>
<t echnol ogyScope>Java</ t echnol ogyScope>
<t echnol ogyScope>JavaBeans</ t echnol ogyScope>
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</t echnol ogyScopes>
<sear chText Cont ext >MySear chCont ext </ sear chText Cont ext >
<litem

Sear chCont ext then implements the Pal et t eSear ch interface, as shown in the following
example:

class MySearchContext inplenents Pal etteSearch

{
bool ean searchltenmContainsText(String itemd, String searchString)

{

bool ean found = fal se;
/1 Search internal data
return found,

}
}

2.4.9 Understanding Preferences

Making a way for your users to modify and store their preferences adds productivity
and flexibility to the process of using your JDeveloper extensions.

2.4.9.1 How to Implement Preferences

You manage product-level preferences with the Pref erences class. For more
information, see Pref er ences in the Java API Reference for Oracle Extension SDK.

The data structure used to store preferences is HashStruct ure, also described in Java
API Reference for Oracle Extension SDK. The Pref erences class saves preferences in
only one extension directory—the extension that represents the entire product. In
JDeveloper, for example, the product directory follows the format j dev- user - di rect ory/
syst e oracl e. JDevel oper. 12. 1. 3. x. y, where "12.1.3" represents the version number
and "x.y" represents the build number. The file holding the preferences is named
preferences. xnl.

To incorporate a new set of preferences into the IDE:
1. Implement the data model for storing the preferences. For more information, see
How to Implement the Data Model.

2. Implement the data model for storing the preference. For more information, see
How to Implement a Ul Panel.

3. Register the Ul panel with the Preferences dialog, which is available from the Tools
menu. For more information, see How to Register a Ul Panel.

4. Obtain the preferences model. For more information, see How to Obtain the
Preference Model.

5. Listen for changes to the preferences, so they can be stored. For more information,
see How to Listen for Changes.

2.4.9.2 How to Implement the Data Model

The class that represents your preferences data should be a subclass of
HashSt r uct ur eAdapt er . For more information, see HashSt r uct ur eAdapt er in the Java API
Reference for Oracle Extension SDK.
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The following example contains a typical implementation pattern, with comments for
the details.

package oracle. killerapp.cool feature;
i mport oracl e.javatool s. dat a. HashStruct ure;
i mport oracle.javatools. data.;
i mport oracl e.javatool s. dat a. PropertySt or age;
/1 Start with class being final. You can always renove final if subclassing ever
/'l proves useful. In many cases, subclassing is actually unnecessary and may get
/1 you into an instanceof/typecast nmess. Consider defining a separate (not
/'l subclass) adapter class instead.
public final class Cool FeaturePrefs extends
{
/1 The DATA _KEY shoul d be a hard-coded String to guarantee that its value stays
/1 constant across releases. Specifically, do NOT
/'l constant across releases. Specifically, do NOT use
Cool Feat urePrefs. cl ass. get Nang().
/1 The reason is that if Cool FeaturePrefs is ever renamed or noved,
/'l Cool FeaturePrefs.class.getName() will cause the DATA KEY String to
change, whi ch
/1 introduces a preferences migration issue (since this key is used in the persisted
/1 XM.) that will require nore code and testing to acconmodate and open up your
code to
/1 annoying little bugs. Unknow ng devel opers have been trapped by this problem
before,
/1 so elimnate this cause of bugs by using a hard-coded String for DATA_KEY.
11
/1 By convention, DATA KEY should be the fully qualified class name of the
Il . This hel ps ensure against nane collisions. This also makes it
Il easier to identify what piece of code is responsible for a preference when you're
/1 looking at the XM in the product-preferences.xm file. O course, that only
wor ks
Il as long as the adapter class itself is never renanmed or moved, so avoid renanm ng
or
/1 moving this class once it's been released in production.
private static final String DATA KEY =
"oracle.killerapp.cool feature. Cool Feat urePrefs";
Il Private constructor enforces use of the public factory method bel ow.
private Cool Feat urePrefs(HashStructure hash)
{
super (hash);
}

/'l Factory nethod shoul d take a PropertyStorage (instead of HashStructure directly).
/'l This decouples the origin of the HashStructure and allows the future possibility
/'l of resolving preferences through nultiple layers of HashStructure. O asses/nethods
/1 that currently inplement/return PropertyStorage:

Il - oracle.ide.config.Preferences

/1 - oracle.ide. nodel . Project

Il - oracle.ide. nodel . Wrkspace

/1 - oracle.ide.panels. Traver sabl eCont ext . get PropertyStorage()

public static Cool FeaturePrefs getlnstance(PropertyStorage prefs)

/] findO Create nakes sure the HashStructure is not null. If it is null, a
Il new enpty HashStructure is created and the default property values will
/1 be determined by the getters bel ow.

return new Cool Feat urePrefs(findOrCreate(prefs, DATA KEY));

/'l Like DATA KEY, all other keys al so appear in the XM, so they should not be
/'l changed once rel eased into production, or else you'll have sone migration issues

2-41



Chapter 2
Creating JDeveloper Elements

Il to fix

private static final String MAX_NUMBER OF TH NG ES = "maxNunber Of Thi ngi es"; [/
NOTRANS

private static final int DEFAULT MAX_NUMBER OF THING ES = 17,

public int get MaxNunber O Thi ngi es()
I/ Specify default in the getint call to take advantage of HashStructure's

/'l placehol der mechanism See HashStructure javadoc for details on placehol ders.
return _hash. get | nt (MAX_NUMBER OF THI NG ES, DEFAULT MAX_NUVBER OF THI NG ES);

}

public void set MaxNunmber Of Thi ngi es(i nt maxNunber O Thi ngi es)
{

_hash. put I nt (MAX_NUMBER_OF _THI NG ES, nmaxNunber Of Thi ngi es) ;
}
e e

private static final String TH NG E_NAME = "thingieName"; //NOTRANS
private static final String DEFAULT_THI NG E_NAME = "wi dget"; //NOTRANS
public String getThingi eName()
{
return _hash. get String(TH NG E_NAME, DEFAULT_THI NG E_NAME) ;
}
public void setThingi eNane(String thingi eNane)
{
return _hash. put String(TH NG E_NAME, thi ngi eNane);
}
Il etc..

}

2.4.9.3 How to Implement a Ul Panel

ORACLE

The class that implements your preferences panel should be a subclass of
Def aul t Tr aver sabl ePanel . For more information, see Def aul t Tr aver sabl ePanel in the
Java API Reference for Oracle Extension SDK.

The following example shows a typical implementation pattern.

package oracle.killerapp.cool feature;

import oracle.ide. panel s. Def aul t Traver sabl ePanel ;

/'l You shoul d keep the panel class package-private and final unless there
/] is a good reason to open it up. |In general, preferences panels are not
/'l supposed to be part of a published API, so the class nodifiers should
/'l enforce that.

final class Cool FeaturePrefsPanel extends Defaul t Traver sabl ePanel

/1 But, the no-arg constructor still needs to be public.
publ i c Cool Feat ur ePref sPanel ()
{

/1 Layout the controls on this panel.
public void onEntry(Traversabl eContext tc)

final Cool FeaturePrefs prefs = get Cool FeaturePrefs(tc);
I/ Load prefs into the panel controls' states.

}

public void onExit(Traversabl eContext tc)

final Cool FeaturePrefs prefs = get Cool Feat urePrefs(tc);
/1 Save the panel controls' states to prefs.

}

private static Cool FeaturePrefs get Cool Feat urePrefs(Traversabl eContext tc)
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/1 1f you've inplenented Cool FeaturePrefs according to the typica
Il inplementation pattern given above, this is how you attach the
I/ adapter class to the defensive copy of the preferences being
/1 edited by the Tool s->Preferences dial og.

return Cool Feat urePrefs. getlnstance(tc.getPropertyStorage());

}
}

2.4.9.4 How to Register a Ul Panel

The following example contains an XML fragment for the extension manifest
(extension.xml) that registers the panel shown above with the Preferences dialog,
which is available from the Tools menu.

<extension ...>
<hooks>
<settings-ui-hook xm ns="http://xm ns.oracl e. confide/ extensi on">
<page id="Cool Feat urePrefs" parent-idref="/preferences">
<| abel >${ SOVE_RES_KEY} </ | abel >
<traversabl e-cl ass>oracl e. ki | | erapp. cool f eat ure. Cool Feat ur ePr ef sPane
</traversabl e-cl ass>
</ page>
</ settings- ui-hook>
</ hooks>
</ extensi on>

2.4.9.5 How to Obtain the Preference Model

Use the oracl e. i de. config. Preferences class to obtain preferences if you need to read
or write preferences in code other than preference dialog code. Do not use this
technique in preference pages. Any changes you make to the preference object using
this code takes immediate effect, which makes it unsuitable for the Preferences dialog,
which should always be cancelable.

Preferences p = oracle.ide.config.Preferences. getPreferences();
Cool FeaturePrefs myPrefs = Cool Feat urePrefs. getlnstance( p );

2.4.9.6 How to Listen for Changes

You can listen for changes to preferences by attaching an

oracl e.javat ool s. dat a. Struct ur eChangelLi st ener to the hash structure underlying your
preferences model object. Usually, a good approach is to expose methods for
attaching a listener to your model object as shown in the following example:

public final class Cool FeaturePrefs extends

{
...
public void addStructureChangeli stener( StructureChangeListener | )
{
_hash. addSt ruct ureChangeLi stener( | );
1
public void renoveStructureChangeLi stener( StructureChangelListener | )
{
_hash. renoveStruct ureChangeLi stener( | );
}

...
}
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2.4.10 Understanding Project Properties

Project properties are similar to project preferences, see Understanding Preferences.

You manage project properties with the Proj ect class. For more information, see
Proj ect in the Java API Reference for Oracle Extension SDK.

2.4.10.1 How to Share Project Properties

ORACLE

When working on an application, it is beneficial to have projects within an application
share property settings. Sharing project properties can be set up either through the
Run/Debug configuration or by customizing an project template by adding a project-
creation listener, which is called whenever that template is used to create a new
project. It allows the extension writer to modify the project's run configurations and
other properties. This section describes setting the Run/Debug configuration to enable
the use of common settings among projects within an application. For a discussion on
adding a project-creation listener to a template, see TBD.

You can configure a project to use a shared run configuration at one of the following
times:

*  When you create the project through the creation listener, which is called when a
project is created with a project template

*  When a technology is added to the project
*  During project migration

JDeveloper provides the Shar edPr oj ect Properti esManager API that you can add to a run
configuration file to enable sharing run configuration properties:

e SharedPropertiesManager - Manages shared properties.
e SharedPropertiesManager getlnstance() - Obtains an instance the shared property.

* HashStructure getProperties(Project project, String propertyDataKey) - Returns
the appropriate properties hash for either a workspace or project.

e propertiesAreShareabl e(String) - Specifies the project properties to share.

* isUsingSharedProperties(Project, String)- Checks if the project uses the specified
shared properties.

e setUsesSharedProperties(Project, String, boolean) - Sets the shared properties
as being used by the project or not.

Use Shar edPr oj ect Properti esManager to configure a project to use shared run
configuration properties, as shown in the following example:

if

( Shar edProj ect Properti esManager. get I nstance(). properti esAreShareabl e( RunConfiguratio
ns. DATA KEY ))

{

Project project = ...;
Shar edPr oj ect Properti esManager. get I nstance() . set UsesShar edProperty( proj ect,
RunConfi gurations. DATA KEY, true );

}

Alternatively, you can set a project to use shared run configuration properties through
the IDE.

2-44



Chapter 2

Creating JDeveloper Elements

To Use A Shared Run Configuration:

1. Right-click the project in the Projects window and select Project Properties.

2. Select Run/Debug in the Project Properties dialog.
3. Select Use Shared Settings on the Run/Debug page.

When you select this option, the shared run configuration is stored in the

application (the . j ws file). Any project within the application can use these property

settings.

4. Select the run configuration to use in the Run Configurations list.

You can add new shareable run configurations or edit existing ones by clicking Edit
Shared Settings (this option is only available if Use Shared Settings is selected).

2.4.11 How to Make Changes Undoable

Users who follow the rapid, iterative model of application development rely on the

ability to easily back out changes as they move from solution to solution. Adding the

ability to make your changes undoable provides this functionality for your users.

2.4.11.1 How to Make Text Changes Undoable

If your extension uses any form of text entry—for example, if you are implementing a
custom text editor with specific features used by your organization—your users will

expect to be able to undo changes they make while entering text. Undoabl eEdi t allows
your extension to do and undo the changes made to text by the user, as shown in the

following example:

i mport javax.swi ng.undo. Undoabl eEdi t;
i mport oracle.ide. Context;
i mport oracle.ide.controller.Conmand,
import oracle.ide.controller.ConmandProcessor;
i mport oracl e.ide. model . Text Node;
import oracle.javatools.buffer. TextBuffer;
public class MyCommand extends Comrand
{
private Undoabl eEdit _undoabl eEdit;
public MyCommand( Cont ext context)
{
super (-1, Conmand. NORMAL, "lInsert Hello");
set Cont ext (context);

public int doit() throws Exception
{
if (_undoabl eEdit == null)

{
final TextNode textNode = (TextNode) context.getNode();

final TextBuffer textBuffer = textNode.acquireTextBuffer();

text Buf fer. begi nEdi t ();
textBuffer.insert(0, "Hello Wrld".toCharArray());
_undoabl eEdit = textBuffer.endEdit();
t ext Node. rel easeText Buffer();
} else

_undoabl eEdi t. redo();

}
return C;

ORACLE
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}

public int undo() throws Exception

_undoabl eEdi t . undo() ;
return oK
1
}

2.4.11.2 How to Make Commands Undoable

If you want to make undoable changes to a document, you have to implement a
command that knows how to do and undo the changes, as shown in the following
example:

import oracle.ide.controller.Command,;
import oracle.ide. Context;

i mport oracle.ide. nodel . Node;

public class M/Command extends Comrand

{
public MyCommand( Cont ext context, Node affectedNode)

{
super (-1, Command. NORMAL, "M Changes");
/1 The context usually already contains the node so this would not be necessary
final Context contextCopy = new Context(context);
cont ext Copy. set Node( af f ect edNode) ;
set Cont ext ( cont ext Copy) ;

public int doit() throws Exception

final Node affectedNode = context.get Node();
/1 Do the changes to the node here
return oK
}
public int undo() throws Exception
final Node affectedNode = context. get Node();
/1 Undo the changes to the node here
return CK;

}
}

2.5 Defining and Using Trigger Hooks

ORACLE

Use trigger hooks to control when JDeveloper loads the extension.
The <tri gger-hooks> element is in the http://xni ns. oracl e. cont i de/ ext ensi on
namespace.

The <tri gger - hooks> element contains three child elements:
* <registry> - used to register trigger hook handlers
e <triggers>-where all trigger hooks are placed

» <rul es> - defines conditions that can be used to conditionally execute a set of
triggers

The IDE provided trigger-hooks are:

e Actions

e Controllers
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2.5.1 How to Regjister a <trigger-hook-handler>

To define your own trigger-hook, you register a trigger hook handler as shown in the
following example:

ORACLE

Menus

Context Menus

Feature Hook

Editor Menu
Accelerators/Shortcut Keys
Gallery Items

Technology Scopes

Editors

NodeFactory Recognizers
IDE Preferences/Settings
Application Preferences/Settings
Project Preferences/Settings
Content Set Providers
Singleton Registration
Application and Project Migrators
URLFileSystem Hook
ImportExport Hook

Menu Customizations Hook
Bridge Extensions Hook

On Project Open Hook

Help Callbacks Hook

Help Hook

Dockable Hook

Historian Hook

External Tools Hook

<registry>
<trigger-hook-handl er
t ag- name="ry- hook"

Chapter 2
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<trigger-hooks xm ns="http//xm ns. oracl e. conl i de/ ext ensi on/ myExt ensi on">

handl er-cl ass="oracl e. i de. ext ensi on. HashSt ruct ur eHook"

nanespace="http://xnl ns. oracl e. com i de/ ext ensi on"

schema- | ocati on="ny- hook. xsd"
regi ster-as-hook="true"/>
</registry>

</trigger-hooks>
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The regi st er- as- hook attribute controls whether or not the extension hook is also
allowed in the <hooks> section. The default value is f al se; only set it to t rue if it makes
sense to support the same element in <hooks>.

If you have an existing declarative hook and you want it to now be a trigger hook, you
need to remove your current hook handler registration and instead register a trigger-
hook-handler.

If you are updating an existing extension built to previous standards used by
JDeveloper, for backward compatibility, you can keep the same namespace you used.
If your existing hook is a child of the old j devel oper - hook and you would also like to
support it as a trigger hook, set the attribute regi st er - as- j devel oper - hook to true.

Extensions outside of the core IDE must use a hook- handl er class that is part of the
core IDE. There are two options you can use:

e oracle.ide. extension. HashStructureHook as the handler-class. If your trigger-hook
is also in <hooks>, or if it can be used in conditional trigger sections, then new
elements are processed by the HashSt ruct ur eHook after you observe the
HashStruct ure. In this situation, your code must listen to the HashSt r uct ur eHook
events.

e DeferredEl ement Vi si t or Hook, allows you to use a custom El enent Vi si t or class to
process your hook's XML data, so if you have already written a custom hook
handler you can reuse your code.

2.5.2 How to Define Trigger Hooks for your Extension

To use a trigger hook, use syntax similar to the following example:

<triggers>
<si ngl et on- provi der - hook>
<singl eton base-class="oracle.bali.xn .addi n. JDevXm Cont ext Fact ory"
i mpl -class="oracl e.bali.xm .addi n. JDevJavaXm Cont ext Factory" />
</ 'si ngl et on- provi der - hook>
</triggers>
</trigger-hooks>

2.5.3 How to Retrieve Parsed Information from the ExtensionRegistry

ORACLE

When you define a tri gger - hook- handl er for an element name, a single instance of
that Ext ensi onHook handler class is created that processes all the usages of that trigger
hook.

To retrieve that Ext ensi onHook instance, call Ext ensi onRegi stry. get Hook( el ement Nane) .
In earlier versions of JDeveloper extension development, this APl was used to retrieve
the Ext ensi onHook for a regular declarative hook. All the processed trigger hooks and
all the currently loaded hooks sections contribute to the same bucket of Ext ensi onHook
instances.

If your tri gger - hook- handl er is HashSt ruct ur eHook, you can retrieve the HashStructure
from the returned HashSt r uct ur eHook instance. It contains the XML information for all
the usages of your element name in the HashStruct ure, as well as stored information
about what extensions the different sections of the HashSt ruct ure came from. You can
use a HashStruct ur eAdapt er subclass to pull information out of the HashStruct ure.
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2.5.4 How to Define Rules and Condition Triggers Sections

This section describes how to define rules and conditions in the extension manifest.

2.5.4.1 How to Define Rules

ORACLE

Rules and rule-types are defined in the <rul es> section of <t ri gger - hooks> in the
extension manifest, ext ensi on. xni .

A rul e-type represents a rule function implemented in Java and describes the
parameters accepted by that function (such as a method signature). There is a set of
built-in rule-types provided by the IDE.

A rule represents a call to a rule function passing specific values for the parameters.
Each rule is given a globally unique id, and then referenced by id from the hooks that
support rules.

The rule framework is oracl e. i de. ext ensi on. rul es in the IDE module.
To define a rule type you must supply:

* Anid by which it is referenced,

*  An implementation class which is a subclass of
oracl e. i de. ext ensi on. rul es. Rul eFuncti on, and list the supported parameters. You
can indicate whether a parameter is optional or required.

The IDE module's ext ensi on. xnl defines several built-in rule types, illustrated in the
following example:

<trigger-hooks xm ns="http://xn ns. oracl e. contide/ ext ensi on" >
<rul es>
<rul e-type id="al ways-enabl ed"
class="oracl e. i de. extension.rul es.functions. Al waysEnabl ed" />

<rul e-type id="any-sel ection-has-attribute"
class="oracl e.ide. extension.rul es.functions. AnySel ecti onHasAttribute">
<suppor t ed- par amet er s>
<param nane="el ement-attribute" required="true"/>
</ support ed- par anet er s>
</rul e-type>
<rul e-type id="context-has-el enent"
class="oracl e. i de. extension. rul es. functi ons. Cont ext HasEl enent " >
<support ed- par amet er s>
<param nane="el ement - cl ass" required="true"/>
</ support ed- par anet er s>
</rul e-type>
<rul e-type id="context-has-node"
class="oracl e. i de. extensi on. rul es. functi ons. Cont ext HasNode" >
<suppor t ed- par amet er s>
<par am nane="node- cl ass" required="true"/>
</ support ed- par anet er s>
</rul e-type>
<rul e-type id="context-has-project"
class="oracl e. i de. extension.rul es.functions. Cont ext HasProj ect" />
<rul e-type id="context-has-vi ew'
class="oracl e. i de. extensi on. rul es. functi ons. Cont ext HasVi ew' >
<suppor t ed- par amet er s>
<par am nane="vi ew cl ass" required="true"/>
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</ support ed- par anet er s>
</rul e-type>
<rul e-type id="context-has-wor kspace"
class="oracl e. i de. extension.rul es. functions. Cont ext Has\Wr kspace" />
<rul e-type id="el ement-has-attribute"
class="oracl e.ide. extension.rul es.functions. El enent HasAttri bute">
<support ed- par amet er s>
<param name="el ement-attribute" required="true"/>
</ support ed- par anet er s>
</rul e-type>
<rul e-type id="on-extension-init"
class="oracl e.ide. extension.rules.functions. Extensionlnitialized">
<support ed- par amet er s>
<par am name="ext ensi on-i d" required="true"/>
</ support ed- par anet er s>
</rul e-type>
<rul e-type id="extension-is-enabl ed"
class="oracl e. i de. extension. rul es. functi ons. Ext ensi onEnabl ed" >
<support ed- par amet er s>
<par am name="ext ensi on-i d" required="true"/>
</ support ed- par anet er s>
</rul e-type>
<rul e-type id="on-singl e-sel ection"
class="oracl e.ide. extension.rul es.functions. Singl eSel ecti on">
<support ed- par amet er s>
<param name="el ement - cl ass" required="fal se"/>
</ support ed- par anet er s>
</rul e-type>
<rul e-type id="on-mul tiple-sel ection"
class="oracl e.ide. extension.rul es.functions. Ml tipleSelection">
<support ed- par amet er s>
<param name="el ement - cl ass" required="fal se"/>
</ support ed- par anet er s>
</rul e-type>
<rul e-type id="node-is-dirty"
class="oracl e.ide. extension.rul es.functions. NodelsDirty" />
<rul e-type id="project-has-techscope"
class="oracl e. i de. extension.rul es.functions. Proj ect HasTechScope" >
<support ed- par amet er s>
<l-- Comma-separated |ist of technology keys -->
<par am nane="t echnol ogy- keys" requi red="true" />
<I-- Specify "all" or "any' for match, to specify if all keys should exist
or any one key suffices -->
<param name="mat ch" required="fal se" />
</ support ed- par anet er s>
</rul e-type>
</rul es>
</ trigger-hooks>

The handler for <rul e-t ype> stores this information for use during parsing of <rul e> and
the runtime evaluation of rules. The rule class is not loaded until the last possible
moment, when a rule needs to be evaluated.

You can introduce your own rule types however there are some restrictions that are
important to understand:

* The IDE never loads a rule type class from an extension that is not fully loaded.
* Rule evaluation never triggers loading an extension.

Consider the case that extension E1 introduces R1-rule-type and T1-trigger-hook.
Imagine that T1-trigger-hook supports using rules. Only when extension E1 is fully
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loaded will it attempt to consume the data from T1-trigger-hook and evaluate any rule
referenced within, so it is perfectly correct to use rules of R1-rule-type with T1-trigger-
hook.

However, if you try to use a rule of type R1-rule-type with an ide-core trigger hook
such as gallery, there is no guarantee that extension E1 would be loaded when that
rule was evaluated, in which case an error is logged.

2.5.4.2 How to Define Simple Rules

A rule is defined in the <rul es> section of <tri gger - hooks>. To define a rule type you
must supply an id by which it is referenced, a type attribute that identifies the rule-type,
and values for any parameters required by the rule-type.

The handler for <r ul e> verifies that, as shown in the subsequent example.

e Theid is unique.

*  The value of type matches the id of a rule-type defined in this extension.xml (or in
the extension.xml of a dependency).

e All required parameters have values.
*  All provided parameters match parameter names defined by the rule type.

<rul es>
<rul e id="context-has-text-node" type="context-has-node">
<par anet er s>
<par am name="node- cl ass" val ue="oracl e. i de. rodel . Text Node" />
</ par anet er s>
</rule>
<rul e id="context-has-source-node-1" type="context-has-node">
<par anet er s>
<par am nane="node- cl ass" val ue="org. product . Sour ceNodel" />
</ par anet er s>
</[rul e>
<rul e id="context-has-source-node-2" type="context-has-node">
<par anet er s>
<par am nane="node- cl ass" val ue="org. product . Sour ceNode2" />
</ par anet er s>
</[rule>
<rule id="on-xxx-init" type="on-extension-init">
<par anet er s>
<par am nane="ext ensi on-i d" val ue="org. product . MyXxxExt ensi on"/ >
</ par anet er s>
</rul e>
<rule id="on-yyy-init" type="on-extension-init">
<par anet er s>
<par am nane="ext ensi on-i d" val ue="org. product . MyYyyExt ensi on"/ >
</ par anet er s>
</rule>
<rul e id="on-text-node-single-selection" type="on-single-selection">
<par anet er s>
<param nanme="el enent - cl ass" val ue="oracl e. i de. nodel . Text Node" />
</ par anet er s>
</rule>
</rul es>
</ trigger-hooks>
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2.5.4.3 Implicitly Available Rules

Each rule-type that has no required parameters is automatically registered as a rule
(using the rule-type ID as the rule ID). For example, cont ext - has- proj ect and node-i s-
di rty are examples of rule-types with no required parameters, and those ids can be
used anywhere a rule is referenced without needing to explicitly add a <rul e> to an
extension. xm .

2.5.4.4 Guidelines for Rules

You can avoid ID duplication and maximize reuse by carefully choosing which
ext ensi on. xni a rule should go into, and the rule name.

The simple rule of thumb is find the extension that contains the class name you are
passing as a parameter, and put it in that extension's ext ensi on. xnl . To define the
cont ext - has- sour ce- node- 1 rules in the example in "How to Define Simple Rules" find
the extension that contains the Sour ceNodel class and look to see if there is an existing
rule that meets your needs. If there is not, add the rule to that ext ensi on. xni .

The ID should be descriptive and based on the rule-type ID, for example:

e context-has-xxx-node

e context-has-xxx-node

e context-has-xxx-element
e context-has-xxx-view

*  on-xxx-single-selection

*  ON-XXx-init

2.5.4.5 How to Define Composite Rules

You can define a rule that is composed of other rules and boolean operators. The
supported boolean operators are <or>, <and>, and <not>. The <and> and <or>
boolean operator elements accept any number of children, and the <not> element
accepts one child. Each child of a boolean operator must be either a rule-reference or
another boolean operator, as illustrated in the following example:

<trigger-hooks xm ns="http://xm ns. oracle.conide/ extensi on">
<rul es>
<conposite-rul e i d="cont ext - has- xxx- or - yyy- node" >
<or >
<rul e-reference id="context-has-jsp-node" />
<rul e-reference i d="context - has-zzz-node" />
</or>
</ conposi te-rul e>
<conposite-rul e i d="on-aaa-and-bbb-init">
<and>
<rul e-reference id="on-aaa-init" />
<rul e-reference id="on-bbb-init /">
</ and>
</ conposi te-rul e>
<conposite-rul e i d="nore-conplicated-conposite-rule">
<or >
<rule-reference id="rule-a" />
<and>
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<rule-reference id="rule-b" />

<not >
<rule-reference id="rule-c" />
</ not >
</ and>
</or>
</ conposi te-rul e>
</rul es>

</ trigger-hooks>

2.5.4.6 How to Reference Rules From Hooks

All rules are defined in the <rul es> section of an ext ensi on. xni and then referenced by
id in hooks that support rules.

A trigger hook that wants to support rules only needs to change its syntax to accept
the id of the rule. By convention, the rule id should be supplied in an attribute named
"rule”. These are illustrated in the three subsequent examples:

Example 1

<item rul e="al ways- enabl ed" >
<name>or acl e. j devel oper.tenpl ate. w zard. Tenpl at eW zar d</ nanme>
<i d>Appl i cation</id>
<descri pti on>${ NEW APPL| CATI ON_TEMPLATE_GALLERY_| TEM </ descri pti on>
<hel p>${ MANAGE_TEMPLATES_W ZARD DESCRI PTI ON} </ hel p>
<f ol der >Appl i cati ons</f ol der >
<t echnol ogyKey>Gener al </ t echnol ogyKey>
<i con>/ oracl e/ j avat ool s/ i cons/ appt enpl at e. j pg</i con>

<litem

</ gal l ery>

Example 2

<controllers xmns="http://xm ns.oracl e. coni de/ ext ensi on">
<controller class="comrandom FooController">
<updat e-rul es>
<update-rul e rul e="on-text-node-sel ected">
<action id="sone.action.idl">
<l abel >Perform Action on {0}</| abel >
<l abel - par an${ node. nane} </ | abel - par an>
</ action>
</ updat e-rul e>
</ updat e-rul es>
</controller>
<controll er class="comrandom BarController">
<updat e-rul es>
<update-rul e rul e="on-j sp-node-sel ect ed" >
<action id="sone.action.id3" />
<action id="sone.action.id4" />
<action id="sone.action.id5" />
</ updat e-rul e>
</ updat e-rul es>
</controller>
</controllers>

Example 3
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<cont ext - nenu- hook rul e="cont ext - has- xxx- or - yyy- node" >
<site ref-id="navigator"/>
<menu>
<section xmns="http://jcp.org/jsr/ 198/ extension-manifest"

i d="MY_CUSTOM MENU_SECTI ON_ONE" wei ght="1.0">
<itemaction-ref="nyTriggerActionld" weight="1.0" />
<itemaction-ref="nyQt herTriggerActionld" weight="2.0" />

</ section>
</ menu>
</ cont ext - menu- hook>

2.5.4.7 How to Validate Rule References and Evaluate Rules

If you are implementing a trigger hook, and you'd like to support rules in your hook, in
your XML syntax add a rule attribute that accepts the ID of a rule (the XML Schema
type for the rule attribute should be xsd: NCNang).

In your hook handler implementation, when you retrieve the value of the rule attribute,
you should call the following method on RuleEngine to do parsing-time validation of
the rule reference:

public static bool ean validateRul eReference(String id, Set<String>
expect edRul eTypes, El enent Cont ext ref erenceCont ext

This method validates that there is a known rule with that ID (in the same

ext ensi on. xni or in a dependency), and if you pass the optional expect edRul eTypes it
validates that the rule is one of those types (if it is a composite rule all the particles
must be of the expected types). If the optional r ef er enceCont ext parameter is passed, it
logs all the problems to the El enent Cont ext 's logger.

When it was time to actually evaluate the rule, you would pass the rule id to a method
on the Rule Engine along with an IDE Context (if available). The Rule Engine
instantiates the rule-type class, pass the parameters from the rule definition, along with
the context, and return true or false.

public static bool ean eval uateRule(String id, Context ideContext)

The first method logs any exceptions that occur during rule evaluation and returns
false if there were any problems evaluating the rule. The latter method also logs any
exceptions, but throws the exception to the caller (in case the caller wants to take a
different action).

2.6 Adding Online Help Support

Create JDeveloper extensions that have online help.

The help system used by JDeveloper provides context-sensitive F1 topics integrated
into the structure of the IDE, where users access help by clicking the Help button in a
wizard panel or a dialog, or by pressing the F1 key.

You can provide similar context-sensitive F1 help topics for your extension to make it
easier for the users of your extension to learn about it and to use it effectively.

2.6.1 How to Create the Help System

You create a help system by providing a helpset, which is a Java archive, containing a
number of HTML help topics.
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For information about creating a help system, see Developing Help Systems with
Oracle Help. For additional resources and to download the Oracle Help for Java
Developer's Kit, see http://wwmu or acl e. conf t echnet wor k/ devel oper - t ool s/ hel p/

i ndex-083946. htn .

To create the help system

1. For each panel of a wizard, or each window or editor, create an HTML topic file
describing the panel.

2. Create a map control file for the helpset.
3. Create a helpset (. HS) control file.

4. Assemble the topic and control files into a Java archive. The archive must have the
same root hame as the HS file, and the HS file must be placed in the archive's root
directory.

5. Make an association between a component and a help topic. For each panel,
provide a call to regi st er Topi ¢ to register the topic ID. For example, if panel is the
name of a wizard panel, and t opi ¢ is the topic ID for its documentation, the call is:

Hel pSyst em get Hel pSyst em() . r egi st er Topi ¢( (JConmponent ) panel , topic)

6. Include the helpset's Java archive in the extension for deployment, so that when
the extension is loaded the help topics are available for users.

2.6.2 How to Register the Help System

The help system for the extension should be available to users before the extension
has loaded so that they can find out about an area of functionality. Therefore the help
system has to be registered as shown in the following example:

<trigger-hooks xm ns="http://xn ns. oracl e.contide/ extensi on">
<triggers>
<hel p xm ns="http://xn ns. oracl e. cont j devel oper/ 1013/ ext ensi on" >
<item
<hel pNane>ej b</ hel pName>
<hel pURL>. . / doc/ $edi ti on/ ohj / hel pset.jar!/hel pset. hs</ hel pURL>
<rel ati veTo>usi ng_di agrans</rel ativeTo>
<rel ativePosition>after</relativePosition>
</item
</ hel p>
</triggers>
</trigger-hooks>

2.7 Adding Print Support

Create JDeveloper extensions that support printing.
JDeveloper provides a default implementation of Docurent Pri nt Fact ory that can create
a Pageabl e object based on a Conponent or a Text Node.

2.7.1 How to Register DocumentPrintFactory

Printing is supported by declaratively registering a Document Pri nt Fact ory in
extension.xm, as shown in the following example:

<hooks>
<print-hook xm ns="http://xnl ns.oracle.conidelextension">
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<docunent Print Factory id="oracle.jdevinpl.hel p. Hel pTopi cDocument Pri nt Fact ory"

class="oracl e. j devi npl . hel p. Hel pTopi cDocunent Pri nt Factory" />
</ print-hook>
</ hooks>

2.7.2 How to Register a View Class to Enable Printing

In order to enable printing from a view you need to register the view class and the
Document Pri nt Fact ory that is used to create a Pageabl e object when print is called on
the view.

The following example shows how to register a pri nt Hel per for

oracl e. i de. navi gat or. Navi gat or W ndow and specifies that the Docurent Pri nt Fact ory that
is registered with the id oracl e. i de. pri nt. Docunent Pri nt Fact ory is used to construct the
Pageabl e object.

<hooks>
<print-hook xm ns="http://xmns.oracle.con ide/extension">
<print Hel per

docunent Pri nt Fact oryl d="oracl e. i deri . navi gat or. Navi gat or Pri nt Fact or y"
vi ew cl ass="oracl e. i de. navi gat or . Navi gat or Wndow" />
</ print-hook>
</ hooks>

If you want to print something else or enhance default printing you have to extend
Docunent Pri nt Fact ory to create the Pageabl e object for your view and register your
implementation of the Document Pri nt Fact ory. The following example shows how to use
the same Docunent Pri nt Fact ory for multiple views.

<print-hook xm ns="http://xn ns.oracle.coniide/extensi on">
<docunent Print Factory id="oracle.jdevinpl.hel p. Hel pTopi cDocument Pri nt Fact ory"

class="oracl e. j devi npl . hel p. Hel pTopi cDocunent Pri nt Fact ory" />
<pri nt Hel per
docunent Print Fact oryl d="or acl e. j devi npl . hel p. Hel pTopi cDocunent Pri nt Fact or y"
vi ew cl ass="oracl e. j devi npl . hel p. Hel pTopi cEdi tor" />
<pri nt Hel per
docunent Pri nt Fact oryl d="or acl e. j devi npl . hel p. Hel pTopi cDocunent Pri nt Fact or y"
vi ewcl ass="oracl e. j devi npl . hel p. Hel pW ndow" />
<pri nt Hel per
docunent Print Fact oryl d="or acl e. j devi npl . hel p. Hel pTopi cDocunent Pri nt Fact or y"
vi ew cl ass="oracl e. j devi npl . hel p. Hel pCont ent Panel " />
<pri nt Hel per
docunent Print Fact oryl d="or acl e. j devi npl . hel p. Hel pTopi cDocunent Pri nt Fact or y"
vi ewcl ass="oracl e. j devi npl . hel p. Hel pCent er W ndow$Hel pCent er Vi ew" />
</ print-hook>
</ hooks>

2.7.2.1 How to Register a PageableFactory implementation for Handling a

Node

ORACLE

JDeveloper provides a default PageableFactory implementation to handle printing
Text Node data.

In some cases you may want to override the standard Pageabl eFact ory implementation
with one that provides the output you want. For example, the Docunent Pri nt Fact ory
registered for the Navi gat or W ndow is the Navi gat or Pri nt Fact ory. When it needs to
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create a Pageabl e object to print it calls Pri nt Manager . cr eat ePageabl eFor Obj ect () which
attempts to look up the best Pageabl eFact ory for the selected element. You can register
a Pageabl eFact ory that is used to handle your node class.

<print-hook xm ns="http://xm ns.oracle.conlidelextension">
<t ext NodePageabl eFact ory node-cl ass="or acl e. nypackage. MyNodeCl ass"
wei ght =" 0. 5" >or acl e. nypackage. MyPageabl eFact or y</
t ext NodePageabl eFact ory>
</ print-hook>

In the previous example the node-class identifies the node that you want to be handled
by the Pageabl eFact ory specified (in this case or acl e. nypackage. MyPageabl eFact ory).
The weight is used to order the list of registered Pageabl eFact ory implementations
when checking for a match for the current element.

2.8 Creating an Application or Project Template

Create custom application and project templates for JDeveloper.

If the application or project templates provided by JDeveloper do not meet your
specific needs, you can define your own application or project template. Application
and project templates are defined declaratively in a module's ext ensi on. xni file and are
loaded automatically in the New Gallery under General > Applications and General >
Projects, respectively. A dynamic wizard is generated from the template definition that
includes an application or project definition page and, optionally, additional
configuration pages, one per project technology.

2.8.1 Defining an Application or Project Template

You define an application or project gallery template using the template-hook in the
ext ension. xni file.

2.8.1.1 Defining Template Hooks
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You use the template hook to create a project and application templates. The
<t enpl at e- hook> element contains the child elements, <pr oj ect Tenpl at e> and
<appl i cati onTenpl ate> and is in the http://xm ns. oracl e. con i de/ ext ensi on
namespace.

Use the <proj ect Tenpl at e> element to define a project template that is displayed in the
project gallery <pr oj ect Tenpl at e> contains the following child elements:

* <name> - Specifies the name of the project as shown in the gallery.
e <tenpl atel d> - Specifies a unique project ID.

e <unsorted> - (Optional) Sorts the template list, putting this item at the top of the list
in the gallery. Not recommend as this element is intended to be used to place the
default template at the top of the list.

e <gal | eryFol der > - In addition to the project, adds a gallery item in the folder.
e <description> - Brief description of the project.
*  <packageNanme> - Displays the default package name.

e <tool Ti p> - (Optional) Displays the path of the project when the cursor hovers over
the project name or icon in the IDE's project window.
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* <icon> - (Optional) Specifies an icon for the project in the gallery.

e <proj ect Name> - Specifies the file name of the project. If no name is specified, a
default name (Proj ect 1, Proj ect 2, ...) is provided.

e <creationListener> - Specifies the creation listener element.

*  <excludeFronal | ery> - Specifies whether this project template is used only in the
context of the given application template. Setting this element to t r ue, hides the
project from the list of available projects in the gallery.

Use the <appl i cati onTenpl at e> element to define an application template that is
displayed in the application gallery. <appl i cati onTenpl at e> contains the following child
elements:

e <nane> - Specifies the name of the application as shown in the gallery.
» <tenpl atel d> - Specifies a unique application ID.

e <unsorted> - (Optional) Sorts the template list, putting this item at the top of the list
in the gallery. Not recommend as this element is intended to be used to place the
default template at the top of the list.

* <gall eryFol der> - In addition to the application, adds a gallery item in the folder.
e <description> - Brief description of the application.
e <packageNanme> - Displays the default package name.

* <tool Ti p> - (Optional) Displays the path of the application when the cursor hovers
over the application name or icon in the IDE's application window.

e <icon> - (Optional) Specifies an icon for the application in the gallery.

*  <applicationName> - Specifies the file name of the application. If no name is
specified, a default name (Appl i cationl, Appl i cation2,...) is provided.

e <project Tenpl at es> - Contains <proj ect Tenpl at e> elements, which specify the
projects within the application.

2.8.1.2 How to Create a Project Template

You declaratively define a project template in a module's ext ensi on. xm file. The
template is loaded automatically in the New Gallery under General > Applications or
General > Projects. A dynamic wizard is generated from the template definition that
includes a project definition page and, optionally, additional configuration pages, one
per project technology.

The following example shows the template definition for a Java Project template:

<proj ect Tenpl at e>
<name>${ TEMPLATE_JAVA PROJECT} </ nanme>
<descri pti on>${ TEMPLATE_JAVA PROJECT_DESC} </ descri pti on>
<packageName>${ TEMPLATE_JAVA PRQIECT PACKAGE} </ packageNane>
<pr oj ect Name>${ TEMPLATE_JAVA PRQIECT_JPR_NAMNE} </ pr oj ect Nane>
<t enpl at el d>j avaPr o] ect Tenpl at e</ t enpl at el d>
<t echnol ogyScope>
<t echnol ogyKey>Java</t echnol ogyKey>
<t echnol ogyKey>Swi ng/ AW</ t echnol ogyKey>
<t echnol ogyKey>JavaBeans</t echnol ogyKey>
</t echnol ogyScope>
</ proj ect Tenpl at e>
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2.8.1.3 How to Create an Application Template

Similarly, you declaratively define an application template in a module's ext ensi on. xni
file. The application template is also loaded automatically in the New Gallery. A
dynamic wizard is generated from the template definition that includes an application
definition page.

The following example shows the template definition for a Java Application template:

<appl i cationTenpl at e>
<nane>${ TEMPLATE_JAVA_APP} </ nane>
<t enpl at el d>j avaAppTenpl at e</ t enpl at el d>
<unsorted>t rue</ unsort ed>
<gal | eryFol der >Gener al </ gal | er yFol der >
<descri pti on>${ TEMPLATE_JAVA APP_DESC} </ descri pti on>
<proj ect Tenpl at es>
<proj ect Tenpl at e>
<t enpl at el d>j avaPr oj ect Tenpl at e</ t enpl at el d>
</ proj ect Tenpl at e>
</ proj ect Tenpl at es>
</ applicationTenpl at e>

2.8.2 Registering a Template

Sometimes an extension requires you to customize a project to support a technology,
independent of the technologies the project currently has. To customize a project, you
can modify the project template to register a creation listener, which is notified when a
project is created from the modified template.

2.8.2.1 Registering a Creation Listener

By registering a creati onLi st ener element, the creation listener is called when a
project is created from the template (identified by its ID) in which the listener is
defined.

The creationLi stener element is optional. The listener is not called if it is not registered
with the template. If called, the listener is called after the project is created as shown in
the following example:

<t enpl at e- hook>
<proj ect Tenpl at e>
<t enpl at el d>t est Cal | backPr oj ect Tenpl at e</ t enpl at el d>
<name>Creation Listener Test Project</nane>
<description>A project for testing creation listener callbacks. </ description>
<proj ect Nane>syl vi a</ pr oj ect Name>
<creationLi stener>oracl e. nyf eat ure. wi zard. \yW zar dCal | back</ cr eat i onLi st ener >
<excl udeFronGal | ery>t rue</ excl udeFrontal | ery>
</ proj ect Tenpl at e>
<appl i cationTenpl at e>
<t enpl at el d>t est Cal | backAppTenpl at e</ t enpl at el d>
<name>Creation Listener Test App</nane>
<description>Creates an application for testing wizard creation |istener
i mpl enent ati on. </ descri ption>
<appl i cati onNanme>W zar dCal | backApp</ appl i cati onNane>
<proj ect Tenpl at es>
<proj ect Tenpl at e>
<t enpl at el d>t est Cal | backPr oj ect Tenpl at e</ t enpl at el d>
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</ proj ect Tenpl at e>
</ proj ect Tenpl at es>
</applicationTenpl at e>
</ tenpl at e- hook>

2.8.3 How to Add a Page for a Technology to the New Application or
Project Wizard

Project templates can have a page that enables a user to include specific technologies
to a project. Optionally, for each of these technologies, you can define a configuration
page that displays in the template creation wizard.

To define a wizard page for a particular technology scope, you need to add the page in
the declaration of the technology scope. The following example shows the definition of
the Java technology scope. This technology scope adds a page to the project creation
wizard. Such wizard pages must extend or acl e. i de. panel s. Def aul t Tr aver sabl ePanel
and implement or acl e. j devel oper . wi zard. t enpl at e. W zar dTr aver sabl e.

<t echnol ogy-hook xm ns="http://xm ns. oracl e. conlide/ extension">
<t echnol ogy>
<key>Java</ key>
<name>${ JAVA TECH} </ name>
<descri pti on>${ JAVA TECH DESC} </ descri pti on>
<wi zar d- pages>
<page>
<traversabl e-
cl ass>oracl e. j devi npl . wi zard. proj ect. JavaTechnol ogyPanel </traversabl e-cl ass>
</ page>
</ wi zar d- pages>
</technol ogy>
</t echnol ogy- hook>

2.8.4 How to Add Additional Pages to an Application Template
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Once you have created an application template, you might find that you want to add an
additional page. For example, you might want to add a page to the template to provide
a page for the user to specify a build configuration. Include the <appl i cat i onAddonPage>
element to your template definition to add an additional page to the create application
wizard.

An application template must define a list of add-on page groups that it subscribes to.
It can subscribe to multiple groups. An add-on pages must define an add-on page
group that it publishes to. It must be a single group. Multiple add-on pages can publish
to the same group. If the same page must be published to multiple groups, create
another add-on page template hook and return the same class name.

Add-on pages are an enhancement of the Application Template API. It provides the
following:

» Ability to add panels to all Application Templates or a specific Application
Template

*  Ability for Application Templates to opt-in to having add-on pages

» Ability to add a panel to beginning of an existing Application Template just after the
application definition

» Ability to add a panel to the end of an existing Application Template
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# Note:

Use the add-on pages only if you absolutely need to and cannot modify the
application template for some reason.

The following example shows an existing template-hook that lives in the ext ensi on. xn
file to define an application template that includes the <addonPageG oups> field to enable
templates to opt-in to add-on page groups:

<appl i cationTenpl at e>
<nane>${ TEMPLATE_JAVA_APP} </ nane>
<t enpl at el d>j avaAppTenpl at e</ t enpl at el d>
<unsorted>t rue</ unsort ed>
<gal | eryFol der >General </ gal | er yFol der >
<descri pti on>${ TEMPLATE_JAVA APP_DESC} </ descri pti on>
<proj ect Tenpl at es>
<proj ect Tenpl at e>
<t enpl at el d>j avaPr oj ect Tenpl at e</ t enpl at el d>
</ proj ect Tenpl at e>
</ proj ect Tenpl at es>
<addonPageG oups>
<addonPageG oup>t est Gr oup</ addonPageG oup>
</ addonPageG oups>
</ applicationTenpl at e>

The <addonPage> element is a section in ext ensi on. xnl of the template-hook that
defines an add-on page as shown in the following example:

<t enpl at e- hook>
<appl i cati onAddonPage>
<name>${ TEMPLATE_TEST_ADDON_PAGE_NAME} </ nanme>

<pagel d>t est Page</ pagel d>
<| abel >${ TEMPLATE_TEST_ADDON_PAGE_LABEL} </ | abel >

Needs to be translated so reference a key in a resource bundle.-->
<title>${ TEMPLATE_TEST_ADDON PAGE TITLE}</title>

<cl ass>oracl e. j devel oper. MyPanel </ cl ass>
<l ocat i on>begi nni ng</| ocat i on>

<addonPageG oup>t est G oup</ addonPageG oup>
</ appl i cati onAddonPage>
</tenpl at e- hook>

The <appl i cati onAddonPage> element contains the following child elements:
*  <nane> - Specifies the page name.
»  <pagel D> - Specifies a unique 1D for the page.

* <l abel > - Specifies the name displayed in the left hand side of the wizard dialog to
show the progress through the wizard.

e <title>- Provides the caption displayed at the top of the wizard to explain more
detail about the wizard page.
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<cl ass> - Declares the panel that you want to create an instance of. It must
implement W zar dTr aver sabl e and Traver sabl e.

<l ocati on> - (Optional) Specifies the placement of the page, at the beginning or
end of the wizard. The value end is the default if this element is not provided.

<addonPageG oup> - Specifies the add-on page group that this add-on page template
is added to.

To add a page to an application template, follow these basic steps:

1. Add the <addonPageG oup> element to the template-hook in your ext ensi on. xni file:

<t enpl at e- hook>
<appl i cati onAddonPage>
<name>t est Page</ nane>
<pagel d>t est Page</ pagel d>
<l abel >dude</| abel >
<title>yo dude</title>
<cl ass>oracl e. j devel oper. MyPanel </ cl ass>
<addonPageG oup>t est G oup</ addonPageG oup>
</ appl i cati onAddonPage>
</t enpl at e- hook>

. Create a component that implements the WizardTraversable, Traversable and

AddonPage interfaces:

public class MyPanel extends JPanel inplenents WzardTraversable, Traversable,
AddonPage

public MyPanel () // The default constructor is the constructor that is called.

{
I...

}

I...
}

. Make sure the Application Template has add-ons enabled:

<appl i cationTenpl at e>
e
<addonPageG oups>
<addonPageG oup>t est Gr oup</ addonPageG oup>
</ addonPageG oups>
</ applicationTenpl at e>
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This chapter describes the Extension SDK, which is available to download to
JDeveloper, and how to use it to develop your own extensions.
This chapter includes the following sections:

e About Developing with the Extension SDK
e Downloading and Installing the Extension SDK
e Using the Sample Extensions

* Running the Sample Projects

3.1 About Developing with the Extension SDK

The JDeveloper Extension Software Developer Kit (SDK) includes a collection of
projects containing sample code and Javadoc-generated documentation for the
Extension API.

Each sample project contains a deployment profile for one-click deployment of the
sample to the appropriate directory. You can also deploy all the projects at once.

You can use the code that provides each extension as a template to help you develop
similar features.

3.2 Downloading and Installing the Extension SDK

ORACLE

Learn how to download and install the Extension SDK to JDeveloper.
You can download and install the Extension SDK using the Check for Updates wizard,
or by downloading it from the Oracle website.

To install the Extension SDK using Check for Updates:

1. Follow the information in "How to Install Extensions with Check for Updates" in
Developing Applications with Oracle JDeveloper, and on the Source page select
the Official Oracle Extensions and Updates update center.

2. On the Updates page, choose Ext ensi on SDK from the list of available extensions,
and click Next. Owing to the size of the extension, it may take a few minutes to
download depending on your internet connection.

3. When you finish the wizard, JDeveloper will restart and install the Extension SDK.
When it restarts, you are asked whether JDeveloper should install the sample
application containing the sample projects described in this chapter. If you answer
yes, the application ext ensi onsdk is open in the Applications window, and the
sample projects are listed.

If you are working behind a firewall, JDeveloper will not be able to connect to the
update center until you enter details of your proxy server. You can either do this in the
Web Browser and Proxy page of the Preferences dialog (available from the Tools
menu), or the Check for Updates wizard will time out and display the Web Browser
and Proxy page.
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To install the Extension SDK using a file:

1. Follow the information in "How to Install Extensions Directly from OTN" in
Developing Applications with Oracle JDeveloper, and navigate to the page for
Official Oracle JDeveloper Extensions.

2. Download the Extension SDK to a local location, then open the Check for Updates
wizard from the Help menu.

3. On the Source page, choose Install from Local File and enter the location of the
esdk_bundl e. zi p file and complete the wizard.

4. JDeveloper will restart and install the Extension SDK. When it restarts, you are
asked whether JDeveloper should install the sample application containing the
sample projects described in this chapter. If you answer yes, the application
ext ensi onsdk is open in the Applications window, and the sample projects are listed.

3.2.1 What Happens When you Install the Extension SDK

When you successfully install the Extension SDK, the sample application is optionally
open in the Applications window, giving you access to the sample projects that
illustrate different aspects of JDeveloper functionality. You can use the code to help
you develop your own extensions.

The Oracle Fusion Middleware Java API Reference for Oracle Extension SDK is
available from the Reference node in the Contents list of the online help (available
from the Help menu).

3.2.2 Troubleshooting Installing the Extension SDK

If you have trouble downloading the Extension SDK and you are working behind a
firewall, ensure that you have set the proxy server settings on the Web Browser and
Proxy page of the Preferences dialog (available from the Tools menu).

If the Check for Updates wizard has located the update center you are using, it may
take up to a couple of minutes before the list of available extensions is displayed,
depending on the speed of your connection.

When you select the Extension SDK in the wizard, it downloads while the wizard is still
open, and this can take a couple of minutes, depending on the speed of your
connection. Once the extension has finished downloading, JDeveloper needs to restart
in order to install it, and a message to this effect is displayed.

3.3 Using the Sample Extensions

ORACLE

JDeveloper’'s Extension SDK has a number of sample projects that illustrate how to
use different types of JDeveloper element.

When you install the Extension SDK, you install an application extensionsdk, which
contains a number of projects that give examples of how to create and use different
types of JDeveloper element.

For information about running the samples, see Running the Sample Projects.
Most of the extension samples are described at:

http:// ww. or acl e. coni t echnet wor k/ devel oper -t ool s/ j dev/ sanpl es- 083838. ht m
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The following list is a sampling of the some of the available sample extension projects
and a brief summary of their main features:

Appl i cationOverview. jpr: Demonstrates how to plug in to the Application Overview
window. Adds a Show Overview menu item to both the Application and Project
context menus. It illustrates how to:

Audi t Ref act or . j pr : Demonstrates using the Audit framework to detect problems in
Java code, and how to write a transform using the refactoring API to fix the
problems automatically.

Bal | oon. j pr: Demonstrates how to install a balloon notification into the JDeveloper
status bar.

O assBrowser. j pr: Shows how to use the JDeveloper d assBrowser .

C assGenerator. j pr: Shows the basic of JOT (Java Object Tool) to generate a java
file in your project. Also demonstrates how to use the Finite State Machine (FSM)
Wizard utility to create a multi step wizard.

C assSpy. j pr: Shows the simplest way to identify the class of a given node in the
Applications window, and how to write its name in the Log window.

C i ckabl eURL. j pr: Shows how to generate a clickable URL in the Log window.

Codel nteraction. j pr: Shows how to get text from the code editor, and launches a
Google search on the currently selected text.

Confi gPanel . j pr: Demonstrates how to store and retrieve preferences, and install a
panel into the Preferences dialog.

CPPagePr ovi der . j pr: Demonstrates how to plug into the component palette using
the palette2 API.

Creat eDi al og. j pr: An example of a simple create dialog invoked from the gallery.

CreateStructure. j pr: Demonstrates creating a new empty application (. j ws file)
and adding a new empty project (. j pr file) to it.

Cust ondi t or . j pr: Shows how to implement your own editor for a given kind of file.
To see the tool in action, open any XML file and switch to the Query page.

Cust onExt ensi onHook. j pr: Demonstrates a custom extension hook, which allows
other extensions to plug into your extension.

Cust onNavi gat or. j pr : Demonstrates how to install a custom Applications window.
Installs a "Favorites" window which can be used to store frequently accessed files.

DebugChj ect Pref er ences. j pr: Demonstrates how to install a custom object
preferences renderer for the Data window of the debugger.

Dockabl eW ndow. j pr: Shows how to implement a custom dockable window.

Ext er nal Tool Creati on. j pr: Shows how to write an addin that installs an external
tools shortcut for an external program. This feature is actually part of the
JDeveloper IDE, and uses a wizard to set up external applications. For more
information about External Tools, see the section "Adding External Tools to
JDeveloper" in Developing Applications with Oracle JDeveloper.

Ext er nal Tool | nport Export. j pr: Imports and exports the properties associated with
a list of External Tools.

Ext er nal Tool Macr os. j pr: Shows how to write an addin that installs a custom macro
for use by external tools.
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Ext er nal Tool Scanner . j pr: Shows how to write a scanner for external tools that can
automatically install external program shortcuts when the user clicks on the Find
Tools button in the External Tools dialog, (available from the Tools menu).

FirstSanpl e.j pr: A sample that illustrates the main concepts involved in writing
extensions for JDeveloper.

Fl at Edi tor. j pr: Demonstrates how to implement a form-based overview editor
similar to the one used for ext ensi on. xm .

Hel | oX. j pr: This is a sample that demonstrates a number of core concepts,
including installing New Gallery items, actions, and menu items.

Layout MenuFi | ter.j pr: Shows how to filter the top level menus in the IDE when the
layout changes.

Met hodCal | Counter. j pr: Uses JOT (Java Object Tool) to count the number of
occurrences of a named method in some code.

OpenNodes. j pr: Implements a dockable window which shows nodes that are open
in the NodeFactory, and tracks when nodes are opened and closed.

When you run this sample, you can choose View > ESDKSample: Open Nodes
to open an Open Node Tracker window, which shows the nodes that are open in
NodeFact ory, and tracks when nodes are opened and closed.

Overl ay. j pr: Shows how to use overlays in the Applications window, like those
used by the version control extensions.

ProgressBar. j pr: Shows how to implement a progress bar during the execution of
some lengthy task.

Proj ect Set ti ngs. j pr: Demonstrates storing and retrieving project properties and
adding custom project settings Ul.

Struct urePane. j pr: Shows how to display your own content in the Structure
Window.

Updat eCent er . j pr: Demonstrates how to install a custom update center as part of
an extension.

3.4 Running the Sample Projects

Learn how to run the sample JDeveloper extension projects.
You can run the sample projects in JDeveloper to see how they work.

To run a sample project:

1.
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The first time you run one of the sample project extensions, you have to right-click
on it and choose Deploy to Target Platform.

To run the extension, right-click and choose Run Extension.

This runs a second copy of JDeveloper with the sample project installed.
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Testing and Debugging Extensions

This chapter describes how to use the tools and features provided by JDeveloper to
run and debug Java programs.
This chapter includes the following sections:

e About Testing and Debugging Extensions
e Debugging Extension Code
e Troubleshooting Debugging

4.1 About Testing and Debugging Extensions

Any extension needs to be tested and debugged for any anomaly before deployment.
You test and debug an extension by installing it and running it in a debug instance of
JDeveloper.

4.2 Debugging Extension Code

Learn how to debug JDeveloper extensions.

JDeveloper provides you with a comprehensive debugger to test your code. For
general information about debugging in JDeveloper, see "Debugging Applications" in
Developing Applications with Oracle JDeveloper.

To debug an extension, you run it in JDeveloper. A new instance of JDeveloper opens
in debug mode with the extension installed. If something is not working correctly then
you can set breakpoints in your extension code to debug it.

4.2.1 How to Run a JDeveloper Extension

When you have developed the code for your extension, you will want to try it out. To
do this you install the extension and then run JDeveloper. A new instance of
JDeveloper runs in debug mode for you to test your extension.

To run an extension in JDeveloper:

«  From the context menu of the project in the Applications window, or in the source
editor, choose Run Extension.

A new version of JDeveloper starts with the extension running in it.

4.2.2 How to Debug a JDeveloper Extension

With the extension running in a debug version of JDeveloper, you can test the
functionality and use the JDeveloper debugging features to find and fix problems. See
"Debugging Applications" in Developing Applications with Oracle JDeveloper.

To debug an extension in JDeveloper:
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1. Enter suitable breakpoints in your code.

2. From the context menu of the project in the Applications window, or in the source

editor, choose Debug Extension.

A new version of JDeveloper starts in debug mode with the extension running in it.

4.3 Troubleshooting Debugging

Discover how to resolve debugging issues with JDeveloper extensions.
Use this list of symptoms and solutions to resolve extension issues:

ORACLE

Symptom: Exception at startup.
Solution: Check stack trace and debug it.
Symptom: Extension does not load.

Solution: Check the Features dialog (available from the Tools menu) to make
sure the extension is enabled when JDeveloper launches. For more information,
see "How to Manage JDeveloper Features" in Developing Applications with Oracle
JDeveloper.

Symptom: Class cast exception.

Solution: For an extension that was written for an earlier version of JDeveloper,
some code has not been migrated, or the extension was compiled against an older
version of JDeveloper. Check to see that the extension has been migrated. For
more information, see Migrating Extensions from Previous Releases.
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Packaging and Deploying Extensions

This chapter describes how to create a package to distribute your extension.
This chapter includes the following sections:

About Packaging and Deploying Extensions
Packaging the Extension
Deploying an Extension

How to Publish an Extension in an Update Center

5.1 About Packaging and Deploying Extensions

Prior to the deployment of an extension, it has to be created and then packaged in an
extension JAR file.
The steps to package and deploy an extension are as follows:

ORACLE

1.

First, you create an extension package which consists of a JAR that is packaged in
an extension bundle archive. The extension bundle archive is a JAR file containing
the extension JAR and any supporting files used by the extension.

The extension JAR file contains:
e The extension manifest file ext ensi on. xm .

e Compiled class files and resources in the same directory structure they had
while they were being developed.

The extension bundle archive contains:
*  One or more extension JAR files.
e Any supporting files such as library JAR files.

Next, you package the extension JAR files into a . zi p file for distribution.

. If this is the first time you have opened the project in JDeveloper, for example if you

are migrating an extension written for an earlier version of JDeveloper, right-click
the project in the Applications window and choose Deploy to Target Platform.
This generates the bundle manifest nani f est. nf if one does not already exist. You
may need to refresh the Applications window.

If the extension references external libraries, open the bundle manifest mani f est . nf
by locating it in the Applications window under the META-INF node, and change
the line

Bundl e- Ol assPat h; .

so that it says:

Bundl e- O assPath: ., external:jdev-install/jdevel oper/jdev/extensions/library
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5.2 Packaging the Extension

Learn how to package JDeveloper extensions for deployment.

When you create an extension project, an extension deployment profile to create an
OSGi bundle is also created. For more information, see "Deployment Profiles” in
Developing Applications with Oracle JDeveloper.

5.2.1 How to Create the Deployment Profile

You set the OSGi bundle profile parameters from the Project Properties dialog.

To edit the deployment profile:

1.

In the Applications window, right-click the project, then choose Properties.
Alternatively, choose Project Properties from the Application menu.

Select Deployment in the panel on the left of the Project Properties dialog. The
extension profile Ext ensi on (Extensi on JAR) is selected. Click Edit.

In the Bundle Options page of the OSGi Bundle Profile dialog, you can enter details
such as the bundle name, version, and activator. For more help at any time, press
F1 or click Help from the dialog.

You set dependencies and set libraries for inclusion by choosing other pages in the
dialog. For more information, see Understanding Dependencies.

Click OK when you are finished editing the deployment profile properties.

5.2.2 How to Create the OSGi Bundle

Once you have edited the deployment profile you can create the OSGi Bundle.

To create the OSGi Bundle:

1.

In the Applications window, right-click the extension project and choose Deploy >
extension-profile to open the Deploy Extension dialog.

The option Deploy to OSGi Bundle is selected. You can click Next to examine
details of the bundle that will be created in the Summary page. When you are
satisfied, click Finish.

The OSGi bundle containing your extension is created in the Or acl e- hone/ j devel oper/
j dev/ ext ensi ons directory.

You can run and debug the OSGi bundle from this location automatically. For more
information, see Testing and Debugging Extensions .

5.3 Deploying an Extension

Learn how to deploy JDeveloper extensions.

Extensions can be distributed to a team by making them available on a file system,
and having users install the extension using the Check for Updates wizard available
from the Help menu. See "Working with Extensions".
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Alternatively, you can make an extension available to a wider audience by hosting it on
the Web somewhere, or you could have it hosted as an open source project so that
other people can help you enhance your extension and further develop it.

Oracle hosts some JDeveloper third party extensions, which are available at http://
wwv, or acl e. cont t echnet wor k/ devel oper -t ool s/ j dev/ i ndex-099997. ht i . If you would like
to upload your extension to this site, post a message on the JDeveloper and ADF
forum at https: //foruns. oracl e. com f oruns/ f or um j spa?f or um D=83.

5.4 How to Publish an Extension in an Update Center

Once you have written and tested an extension for JDeveloper you can make it
available in a JDeveloper Update Center, from where users can download it and have
it automatically install on top of their JDeveloper installation.

Update centers for JDeveloper extensions are online at http://www.oracle.com/
technetwork/developer-tools/jdev/index-099997.html, including the Oracle JDeveloper
Third Party Extension Exchange which lists extensions developed by third-party
companies and individual developers.

For information about how users install updates using the JDeveloper Update Center,
see Working with the Extension Manifest in Developing Extensions for Oracle
JDeveloper.

In order for your extension to be installable using JDeveloper’'s Check for Updates
feature:

1. Create a bundl e. xm file for the extension.

2. In Project Properties, create a Jar deployment profile which uses the file
extension . zi p rather than .jar.

3. With Profile Dependencies selected, ensure that the extension project is selected.

4. With File Groups selected, create a new file group for bundl e. xmi and specify the
target directory as META- | NF.

When you deploy the project using the new deployment profile the ZIP file is
created, and this can be used on its own to distribute the extension. However, if
you want to distribute the extension using an update center you have to create an
update center XML file.

5. If you want to distribute the extension using an update center you have to create an
update center XML file. Then in the Check for Updates dialog (available from the
Help menu) to create a new update center pointing to the URL in the update center
XML file.

You can have users add the new update center to their instance of JDeveloper so that
they can download and install your extension.

5.4.1 Extension bundle.xml Document

ORACLE

This describes the bundl e. xni document which you need to deploy and distribute an
extension.

bundle.xml

Create a document called bundle.xml similar to the following example.
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# Note:

The metadata in bundl e. xri must contain the u namespace, as shown in the
example below.

<?xm version = '1.0" encoding = 'UTF-8' 2>
<updat e- bundl e version="1.0"
xm ns="http://xm ns. oracl e. conl j devel oper/ updat ebundl e"
xm ns:u="http://xn ns. oracl e. conl j devel oper/ updat e" >
<u:update id=" organization. dev.extension ">
<u: nanme>Nane of Extension</u: nane>
<u:version>1. 0</ u: versi on>
<u: aut hor >Your Or gani zat i on</ u: aut hor >
<u:author-url> http://ww. organi zation. coni dev/i ndex. ht m / </ u: aut hor-url >
<u: description>Provi des support for a feature
</ u:description>
<u:requirenent s>
<u: requires-extension id="oracle.j devel oper"
m nVersion="12. 1. 2"
maxVersion="12.2.1" />
</u:requires-agreement url="META-|NF/ agreement.htn" />
</ u:requirenents>
<u: destination>${oracl e. home} </ u: destination>
</ u: updat e>
</ updat e- bund| e>

Important Elements and Attributes

Update Id
Each extension is identified by a unique id and the JDeveloper update center will refer
to your extension using it.

Destination
This optional attribute is the install location and two macro values are available:

oracl e. hone, (default) the JDeveloper directory, for example, C:\ or acl e\ ni ddl ewar e
\j devel oper.

oracl e. nw. home, which can be used when you want to install extensions or patches
in the middleware home directory above the jdeveloper directory, for example, C
\oracl e\ m ddl eware .

Requires Agreement
This optional attribute which brings up the specified URL in the default browser for the
user to provide agreement for using some technology.

Requires Extension minVersion and maxVersion
Use to specify the JDeveloper versions that the extension is for.
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5.4.2 Update Center XML Document

ORACLE

This describes the update center XML document which you need to distribute an
extension from an update center through JDeveloper’s Check for Updates feature.

Update Center XML File

The update center file is similar to bundl e. xn but it has an additional element, bundl e-
ur |, which specifies the location of the extension ZIP file. For more information about
bundl e-url, see .

<?xm version = "1.0" encoding = 'UTF-8' 7>
<updat e- bundl e version="1.0"
xm ns="http://xm ns. oracl e. conl j devel oper/ updat ebundl e"
xm ns:u="http://xn ns. oracl e. conl j devel oper/ updat e" >
<u:update id=" organization. dev.extension ">
<u: nanme>Nane of Extension</u: nane>
<u:version>1. 0</ u: versi on>
<u: aut hor >Your Or gani zat i on</ u: aut hor >
<u:author-url> http://ww. organi zation. con dev/i ndex. ht m / </ u: aut hor-url >
<u: description>
</ u:description>
<u:requirenent s>
<u:requires-extension id="oracl e.j devel oper"
m nVersion="12. 1. 2"
maxVersion="12.2.1" />
</u:requires-agreenent url="META-|NF/ agreement.htm" />
</ u:requirenents>
<u: destination>${oracl e. home} </ u: desti nati on>
<u: bundl e-url > http://ww. organi zati on. com dev/ ext ensi on. zi p/ </ u: bundl e-ur| >
</ u: updat e>
</ updat e- bund| e>

5-5



Chapter 5

How to Publish an Extension in an Update Center

ORACLE" 5-6



Elements Installed with the Extension SDK

This appendix provides information about the elements installed with the Extension
SDK.
The appendix contains the following sections:

e Elements Installed in the File System

e Elements Installed in the IDE

A.1 Elements Installed in the File System

Learn the location of the JDeveloper Extension SDK documentation and sample
application.
When you install the Extension SDK:

*  The Extension SDK APl documentation is installed in j dev_i nstal | / j devel oper/
j dev/ ext ensi ons/ or acl e. j devel oper. esdk/ doc.

*  The extension samples application ext ensi onsdk. j ws which contains the sample
projects is installed in j dev_i nstal | /j devel oper/ mywor k/ ext ensi on-
sanpl es- 12. 1. 3. 0. nn. nnnnnn. nnnn (the value of n is the label number, for example,
ext ensi on-sanpl es-12. 1. 3. 0. 41. 131204. 1931).

A.2 Elements Installed in the IDE

ORACLE

Learn what is present after installing the JDeveloper Extension SDK.
After downloading and installing the Extension SDK, and restarting JDeveloper the
following elements are present in the IDE:

« If you have chosen to install the samples, the application ext ensi onsdk. j ws is open
in the Applications window. If you choose not to install the samples when
JDeveloper restarts, you can open the extension SDK samples application at a
later time from Help > Open Extension Samples.

* In the Manage Features for Studio Developer Role dialog, available from Features
on the Tools menu, ESDK Samples is listed under the IDE node.

The Oracle Fusion Middleware Java AP| Reference for Oracle Extension SDK is
added to the Reference node in the JDeveloper online help Contents.
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Uninstalling the Extension SDK

This appendix provides information about disabling and uninstalling the Extension
SDK.
The appendix contains the following sections:

e About Uninstalling the Extension SDK
* How to Disable the Extension SDK
»  How to Delete the Sample Application

e How to Uninstall the Extension SDK

B.1 About Uninstalling the Extension SDK

JDeveloper extensions are easy to uninstall or just disable to optimize the system
performance.

You can disable the Extension SDK JDeveloper and enable it at a later time so that
you do not have to download and install the Extension SDK afresh, or you can
uninstall the sample application, ext ensi onsdk. j ws and its projects, or you can
completely remove the Extension SDK from your machine.

B.2 How to Disable the Extension SDK
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Learn how to disable the JDeveloper Extension SDK.

When you work with JDeveloper you choose a role in which to work, and the role you
choose determines which JDeveloper extensions are loaded. In general, different
roles remove JDeveloper extensions that are not needed so that JDeveloper
performance is optimized. Indeed, you can create your own JDeveloper role that
disables the extensions you do not want to work with and modifies the menus that are
loaded when the IDE starts. For more information, see "Working with JDeveloper
Roles" in the Developing Applications with Oracle JDeveloper.

If you want to disable the Extension SDK, you can do this in the same way that you
would disable any other JDeveloper extension.

To disable the Extension SDK:

1. From the Tools menu choose Features to open the Manage Features for Studio
Developer Role dialog. This displays all the extensions that are available for the
role in which you are working.

For more information at any time, press F1 or click Help from within the dialog.

2. If necessary, expand the IDE node, and uncheck ESDK Samples.

If you later want to use the Extension SDK, you can enable it by navigating to the
same dialog and checking ESDK Samples.
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B.3 How to Delete the Sample Application

Learn how to delete the JDeveloper Extension SDK sample application.
You can delete the sample application, ext ensi onsdk. j ws, and the projects it contains in
the same way that you can delete any JDeveloper application.

To delete the sample application:

1. In the Applications window, click the Application menu dropdown list (next to the
name of the application, ext ensi onsdk).

2. Select Delete Application.

3. In the Confirm Delete Application dialog, choose Yes.

Alternatively, right-click ext ensi onsdk in the Applications window toolbar, and choose

Delete Application.

JDeveloper will delete the ext ensi onsdk application, including all its projects and their
directories.

B.4 How to Uninstall the Extension SDK
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Learn how to uninstall the JDeveloper Extension SDK.

When the Extension SDK is installed, it places the Extension SDK API documentation
injdev_install/jdevel oper/jdev/extensions, where jdev_install is the directory that
JDeveloper is installed in, and the extension samples application ext ensi onsdk. j ws
which contains the sample projects in j dev_i nstal | / j devel oper/ mywor k.

You can completely remove the Extension SDK from your local drive by deleting:

* jdev_install/jdevel oper/jdev/extensions/oracle.jdevel oper.esdk

° jdev_install/jdevel oper/nmywork/ extension-sanpl es-11.1.2.0.nn.nn.nn
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